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1 Important Safety Information 
This chapter provides important safety information you need to know about using the LeadCare Ultra® 
Blood Lead Testing System.  

 

WARNING: A warning in this User’s Guide indicates a potentially hazardous situation 
that, if not avoided, could result in serious personal injury or death to you or others. 
Warnings are referenced by the signal word WARNING and the warning symbol to the 
left. 

 

WARNING: A biohazard warning in this User’s Guide indicates that the user must use 
precautions to prevent any infections or hazards that can be caused by biological 
samples. Biohazard warnings are referenced by the signal word WARNING and the 
warning symbol to the left. 

 

CAUTION: A caution in this User’s Guide indicates conditions or practices that could 
cause erroneous results or damage to the analyzer. Cautions are referenced by the 
signal word CAUTION and the warning symbol to the left. 

 

NOTE: 

 

A NOTE in this User’s Guide provides additional information that helps you perform 
procedures correctly, or may help you understand how the system works. 
 

 
 

1.1 Avoid Injuring Yourself 
Lab personnel using the LeadCare Ultra Blood Lead Testing System must take steps to avoid contact 
with blood or treatment reagent. 
 

 

WARNING: Read and follow these safety precautions, and the safety precautions 
throughout this User’s Guide. Failure to do so could result in injury to lab personnel. 

 

 

WARNING: Blood can transmit infectious diseases. Use universal precautions while 
collecting and handling blood samples. Follow the procedures set up by your institution 
for meeting federal, state, and local regulations. 

 

 

WARNING: Be careful when handling the LeadCare Ultra Treatment Reagent. The 
treatment reagent contains dilute hydrochloric acid (HCl). Reagent vials and vial 
packaging are designed to minimize chances of leaks during shipping or under normal 
use. Refer to the LeadCare Ultra Treatment Reagent Safety Data Sheet that appears in 
Appendix C of this User’s Guide. 

http://www.magellandx.com/
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1.2 Avoid Injuring Patients 
Patients could suffer injury if the LeadCare Ultra System is used incorrectly and inaccurate blood lead 
results are reported. 
 

 

CAUTION: Read and follow the safety precautions throughout this User’s Guide. 
Failure to do so could result in injury from inaccurate test results. 

 

1.3 Avoid Damaging the System 
The LeadCare Ultra Blood Lead Testing System contains precision equipment. Follow all operation and 
maintenance instructions in this User’s Guide to avoid damaging it. 

 

CAUTION: Read and follow the manufacturer’s instructions for use. 

1.4 Avoid Losing Blood Lead Test Result Files 
Patients’ health and well-being depends on receiving accurate test results. Always work carefully to 
avoid losing or damaging test data and records. 

 

CAUTION: Ensure that results are backed up to the appropriate media. This 
practice will enable you to retrieve and restore data to the LeadCare Ultra System, if 
necessary. See instructions in Chapter 9 for details. 

1.5 Biohazard Warnings 
When handling biological samples, use personal protection equipment and other precautions to prevent 
any infections or hazards that can be caused by the samples. 

 

WARNING: Follow your laboratory’s procedures and regulations when handling 
and disposing of biohazardous materials. 

 

 

WARNING: Blood can transmit infectious disease. Use universal precautions 
while collecting and handling blood samples. Follow the procedures established 
by your institution for meeting federal, state, and local regulations. 
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2 About this User’s Guide 
This User’s Guide is designed to instruct laboratory personnel on the proper and safe use of the 
LeadCare Ultra® Blood Lead Testing System. All operating instructions, product illustrations, screen 
graphics, troubleshooting or error messages, and other relevant information are contained in this User’s 
Guide. It is the user’s responsibility to ensure that all instructions and safety precautions in this User’s 
Guide are strictly followed. 

2.1 Intended Use 
The LeadCare Ultra Blood Lead Testing System is designed to quantitatively measure the amount of 
lead in a capillary whole blood sample. The LeadCare Ultra Blood Lead Testing System is intended for 
in vitro (external) use only. The test kit components are designed for use with both the LeadCare Ultra 
and LeadCare Plus ®  Blood Lead Testing Systems. 

This test system is for prescription use only. This system is not intended for point of care use.  

2.2 Clinical Laboratory Improvement Amendments (CLIA) 
Classification 

The LeadCare Ultra System has been evaluated and cleared by the United States Food and Drug 
Administration for use as a quantitative blood lead test with the following classification: Moderately 
Complex. Facilities must be certified according to CLIA guidelines and must comply with all applicable 
federal, state, and local laws. 

 

WARNING: All laboratories should follow the manufacturer’s instructions and safety 
precautions as specified in the LeadCare Ultra User’s Guide (this guide) and the 
other documents listed in Section 2.3. 

2.3 Additional Documentation 
The following documents provide additional information to users of the LeadCare Ultra Blood Lead 
Testing System: 

• LeadCare Ultra Blood Lead Testing System Package Insert (English) – Part Number 70-8091 

http://www.magellandx.com/
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2.4 User Assistance 
Should you experience any difficulty installing or operating your LeadCare Ultra Blood Lead Testing 
System, please contact your Magellan Diagnostics, Inc. representative. The Troubleshooting chapter in 
this manual (Chapter 7) includes a list of potential system problems, possible causes, and corrective 
actions. Read this chapter carefully. 

If you continue to experience problems with setup, operation, or maintenance, call Magellan 
Diagnostics, Inc. at 800-275-0102. Product Support Specialists are available to answer your questions 
8:00 a.m. to 6:00 p.m. Eastern Standard Time (EST), Monday through Friday. You can also contact 
Product Support by email at LeadCareSupport@magellandx.com. 

2.5 Acronyms 
The following acronyms are used in this User’s Guide: 

Acronym or Term  Definition  

UA  LeadCare Ultra User Application Software  

LIMS  Laboratory Information Management System  

QC Quality Control 

BLL Blood Lead Level 

HCl Hydrochloric acid 

LIS Laboratory Information System 

 

2.6 Compliance Statements 
The LeadCare Ultra Blood Lead Testing System meets the compliance statements listed below. 

2.6.1 CE Mark 

 
IVD - 98/79/EC (27/10/1998) – Annex I and III 

2.6.2 EMC Directive 
Complies with:  
EMC Directive 89/336/EEC EMC Standard EN 61326, FCC Part 15 Subpart B Class B. 
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2.6.3 Safety 
Complies with:  
Low Voltage Directive 73/23/EEC, EN61010-1:2001 (EU) UL61010-1:2004 (USA) CSA C22.2  
No. 61010-1:2004 (Canada) Requirements for In Vitro Diagnostic (IVD) IEC 61010-2-101:2002. 

NOTE: Protection of this equipment may be impaired if operated in a way not described 
in this User’s Guide. Use only the accessories and cables supplied or specified. 

 

 

The ETL label on the bottom of the instrument indicates that Intertek Electrical 
Testing Labs (ETL) has certified the LeadCare Ultra to the applicable safety 
standards.  

2.6.4 FCC 

 
This device complies with Part 15 of the FCC rules. Operation is subject to the 
following two rules: 

1. This device may not cause harmful interference.  
2. This device must accept any interference received, including interference 

that may cause undesired operation. 

2.6.5 Waste Electrical and Electronic Equipment 
 

 

 

 

2.6.6 Part 11 Compliance 
The LeadCare Ultra system has been developed to be in compliance with applicable sections of the 
FDA Electronic Records; Electronic Signatures regulations 21 CFR Part 11. In complying with this 
regulation, the LeadCare Ultra User Application is designed so that editing of patient results cannot 
occur. Once a blood lead test has been completed and results obtained on the software, editing 
functions are restricted to: 

• Adding a comment to a result 
 

NOTE: Currently there is no “audit trail” function associated with patient results data. 

 
User-entered comments and the patient sample type are information provided for reference only and 
are excluded from the LeadCare Ultra 21 CFR Part 11 compliance.  

For electronic signatures the Ultra software uses a combination process of user name and password. 
User account controls are used to maintain the integrity of each User’s account credentials. As part of 

 

This device complies with the Waste Electrical and Electronic Equipment 
(WEEE) directive of the European Union (EU). For information regarding the 
proper decontamination procedure for this product, please contact Magellan 
Diagnostics. Instruments labeled with the associated symbol (see left) must not 
be disposed of as regular waste material. 
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this, Administrator and Operator Users of the LeadCare Ultra User Application will be notified that their 
password is no longer current in instances where: 

• Their password has expired 
• Their password has been changed by the LeadCare Ultra Account Manager 

 
This notification will be provided securely upon entry of the old password. In the case of an expired 
password, the User will be provided with the opportunity to enter a new password in a secure manner. 

The LeadCare Ultra system is intended to be used with LIMS or other third party software for blood lead 
test result data handling. Magellan Diagnostics' responsibility for compliance with 21 CFR Part 11 
compliance ends upon the transfer of results data to the End User's computer network. 
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2.6.7 Symbols 
The following symbols are used in the labeling of the LeadCare Ultra Analyzer and Blood Lead Test Kit. 

Symbol Description 

 
Temperature Limitation 

 
Use By 

 
Manufacturer 

 
Batch Code 

 
Biological Risk 

 Caution: See Instructions for Use 

 
Consult Instructions for Use 

 
Catalog Number 

 
Serial Number 

 
In Vitro Diagnostic Medical Device 

 
Authorized Representative in the European Union 

О Off (supply) 

І On (supply) 

 Prescription Use Only 
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3 System Overview 
3.1 Introduction 
This chapter describes the operation and major components of the LeadCare Ultra® Blood Lead 
Testing System. Major components include the analyzer, monitor and computer with dedicated User 
Application (UA) software, barcode scanner, keyboard, and test kit. The LeadCare Ultra Blood Lead 
Testing System is designed to quantitatively measure the amount of lead in a capillary whole blood 
sample. The LeadCare Ultra Blood Lead Testing System is intended for in vitro (external) use only. The 
test kit components are designed for use with both the LeadCare Ultra and LeadCare® Plus™ Blood 
Lead Testing Systems. 

The LeadCare Ultra System features include: 
• User-friendly LeadCare Ultra User Application software. 
• Barcode scanner and keyboard for data entry. 
• Six channels, allowing you to run six blood lead tests simultaneously. 
• Data management system that maintains test records for archiving and uploading to LIS. 

 
NOTE: Power down the LeadCare Ultra System before relocating or moving. 

Failure to do so could damage the system. 
 

3.2 About Blood Lead Testing 
According to the US Centers for Disease Control (CDC), there is no known safe level of lead. Consult 
your local public health department and/or CDC recommendations for information on the management 
of blood lead levels. 

3.3 How the LeadCare Ultra System Works 
The LeadCare Ultra System relies on electrochemistry (Anodic Stripping Voltammetry or ASV) and a 
unique sensor to detect lead in whole blood. Most lead is carried within red blood cells. When a sample 
of whole blood is mixed with treatment reagent (a dilute solution of HCl), the red blood cells are lysed 
and the lead becomes available for detection. When a test is run, the analyzer applies an electrical 
potential that causes the lead to collect on the sensor. After three minutes, the analyzer measures the 
amount of lead on the sensor and displays the result in micrograms per deciliter (µg/dL). 

http://www.magellandx.com/
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3.4 System Components 
The LeadCare Ultra Blood Lead Testing System is a fully integrated, multi-component sytem. A 
Magellan Diagnostic, Inc. representative will install your system, assist in setting up User accounts, and 
provide general on-site user training. 

The LeadCare Ultra Blood Lead Testing System is shipped with the following components  
(see Figure 3-1). 

 
Figure 3-1: Major Components of the LeadCare Ultra Blood Testing System 

3.4.1 Analyzer 
The six-channel LeadCare Ultra Analyzer performs up to six blood lead tests simultaneously and 
uploads the completed test results to the computer. Test results are stored in the computer in unique 
sample records, along with Sample ID, Comments, Test Conditions, Sensor Lot #, and User ID. The 
analyzer is also equipped with a calibration button reader. This reader allows for the download of all 
calibration information, analytical test parameters, and date code information for any given sensor lot. 
These actions can be accomplished by simply touching the appropriate calibration button to the reader. 
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3.4.2 Flat Screen Monitor 
The dedicated UA (User Application) software displays an easy to use operating environment on a flat 
screen monitor. The monitor sits in back of the analyzer so that the six sensor channels on the analyzer 
align with the six sensor channels depicted on the monitor screen. This layout allows you to see a direct 
correlation between instructions on the screen and the individual sensor channels. 

3.4.3 Computer 
The system’s computer is dedicated to running ONLY blood lead analyses, and sits on a stand directly 
behind the monitor. The computer serves as the user interface for entering patient ID information. It 
also performs data analysis after blood lead measurements are processed by the firmware embedded 
in the analyzer. The computer stores the patient results allowing for retrieval at a later date and time. 
The computer also allows connectivity via USB ports to a customer-supplied printer and LIS.   

NOTE: Power down the LeadCare Ultra System before relocating or moving. 
Failure to do so could damage the system. 

3.4.4 Barcode Scanner 
The barcode scanner is designed as the primary method for entering Sample ID information 
automatically without manual keying of data. For initialization instructions, please refer to Appendix B 
Setup Guide. 

3.4.5 Keyboard 
A keyboard allows you to log in to the system, enter sample information, and type comments about a 
particular sample. 

3.4.6 Test Kit 
The LeadCare Ultra Test Kit contains the supplies (treatment reagent, sensors, control material  
and a calibration button) and instructions for use, required to perform 192 blood lead tests. The 
complimentary test kit allows the lab to perform validation studies. Figure 3-2 and Table 3-1 illustrate 
and describe the contents of a test kit. 
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Figure 3-2: Test Kit Contents 

 

Table 3-1: Test Kit Contents 

 Item Name Description 

1 Treatment Reagent The treatment reagent is a clear liquid (dilute solution of HCl) 
that contains black particulates (activated carbon). When a 
treatment reagent vial is agitated, the black particles disperse 
throughout the liquid, imparting a black color to the resulting 
suspension. Over time the particles settle to the bottom of the 
vial, leaving a black solid at the bottom of the clear liquid. 

2 Sensors The sensors are single use electrochemical test strips that are 
inserted into the LeadCare Ultra Analyzer and used for the 
binding, release and measurement of lead present in a test 
sample. 

3 Control Material Two control material vials (Level I and Level II) are supplied in 
each test kit. The controls are buffered acqueous solutions 
containing bovine serum albumin, dye, and a known amount of 
lead. The control material is used to demonstrate that the 
system is correctly measuring the lead concentration in a 
sample preparation. 

4 Calibration Button The calibration button is specific for the test kit in which it is 
supplied. It is used to download all calibration information, 
analytical test parameters, and expiration date code 
information for the sensor lot supplied within the test kit. This 
lot-specific calibration button is held against the calibration 
reader on the analyzer to calibrate the analyzer for use with a 
particular test kit. 

1 

2 

3 

4 
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3.4.7 User Application (UA) Software 
The User Application (UA) software is a Microsoft Windows-based application dedicated to blood lead 
testing. Figure 3-3 shows the Main UA screen, and Table 3-2 identifies and describes the major 
software menus and options.   

 

Figure 3-3: LeadCare Ultra UA Software Screen 

3 
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Table 3-2: Main UA Screen Components 

 Name Description 

1 Menu Bar Use the menu bar to access LeadCare Ultra System functions. 
The top-level menu includes these options: File, View, Tools, 
and Help. 

See Table 3-3 for descriptions of all menu functionality. 
2 User The person currently logged into the system. 
3 Sensor Lot # Indicates the current lot of sensors in use, as determined 

during calibration. 
4 All Tests Menu Bar Displays column headers of; Sample ID, Test Date, Result, 

Controls Out of Range, Patient Sample Type, Channel #, 
Sensor Lot #, User, and Comments. In addition, allows the 
user to “sort” by any of these options. 

5 All Tests List  Displays all test results that have not been approved or 
archived. 

6 Result Options 
Menu 

Activated by right-clicking on a sample record in the data table 
on the main UA screen. Options allow you to Void a Test, 
Change Patient Sample Type, Edit Test Comments, and 
Approve/Archive Selected or All Test Results. 

7 Total Records Displays the total number of unapproved test results. 
8 Sensor Channels  Represents the six channels where testing takes place. 

 
NOTE: The UA functions are operable when the power to the analyzer is turned off. 

However, power to the analyzer must be on to perform blood lead testing. 
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Table 3-3: LeadCare Ultra Main Screen Major Elements 

Menu Option Description 

File 

Backup Records Lets you backup test records to a CD/DVD media via a 
standard Windows dialog box. (see Section 9.1.1) (Admin only) 

Restore Records Lets you restore (copy) test results stored on a CD/DVD  
media via a standard Windows dialog box. (see Section 9.1.2) 
(Admin only) 

Exit Lets you exit the LeadCare Ultra UA. 

View 

Unapproved Tests Displays a dialog box that lets you search for and display 
unapproved test results; you can search by test date range or 
by specific values. 

Archived Tests Displays a dialog box that lets you search for and display 
archived tests; you can search by test date range or by 
specified values (see Section 6.7.1.) 

Quality Control 
Tests 

Displays a dialog box that lets you search for and display 
Quality Control tests; you can search by all QC values, by test 
date range, or by specified values (see Section 5.8). 

Error History Displays a dialog box that lets you search for and display error 
history; you can search by all errors or by specified values (see 
Section 8.2). (Admin and/or Operator Accessible) 

Calibration History Displays a dialog box that lets you search for and display 
calibration records; you can search by all calibration records or 
by specified values (see Section 8.1). (Admin and/or Operator 
Accessible)  

User Login History Displays a dialog box that lets you search for and display User 
login history; you can search by all User login records or by 
specified values (see Section 8.3). (Admin and/or Operator 
Accessible)  

Tools 

Set the Quality 
Control Levels 

Displays a dialog box that lets you specify QC levels for a 
particular QC lot code. You can also specify the number of QC 
levels and the accepted tolerance range in µg/dL.  
(see Section 4.4) 

Set the Patient Test 
Limits 

Displays a dialog box that lets you specify the number of test 
limits, a particular limit name, and the accepted tolerance 
range in µg/dL (see Section 4.5). 

Set the Default 
Patient Sample 
Type 

Set the default patient sample type to capillary. Select 
capillary. Do NOT use venous samples. 

Set Approved Tests 
File Type 

Displays a dialog box that lets you choose between CSV or 
XML as a file type (see Section 6.7.2). (Admin only) 

LIS > Settings Displays a dialog box that lets you Enable the LIS interface, set 
the TCP Port number, and change OBX-5 message segment 
format. (see Section 8.5). (Admin only; Users can view 
settings.) 

LIS > Status Displays a dialog box that lets you view the status of the 
connection status, TCP Address, TCP Port and the Queue. 
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Menu Option Description 

Help About LeadCare 
Ultra 

Displays the version numbers of the software and firmware of 
the analyzer. 

 

3.4.8 Printer 
A printer can be connected to the LeadCare Ultra System. See Appendix B for instructions. 
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4 Calibration and Quality Control 
Setup 

4.1 Introduction 
Once the LeadCare Ultra® System has been installed and User accounts have been established, the 
system is ready for daily use. This chapter describes calibration, entering quality control settings, and 
setting patient test limits. These steps are required prior to testing. 

4.2 How Calibration Works 
Each LeadCare Ultra Test Kit comes with one calibration button for the sensors. The calibration button 
is coded with the data required for the analyzer to translate the raw signal measured on the sensor into 
the actual lead concentration of blood samples. 

When you touch the calibration button to the button reader on the analyzer, the calibration data for the 
sensor lot is transferred to the analyzer. When the transfer is complete, an audible tone sounds and a 
“Calibration Successful” message appears. The lot number from the calibration button is then displayed 
in the upper left-hand corner of the UA. 

4.3 Calibration Procedure 
You must calibrate the analyzer: 

• The first time you use the analyzer. 
• Each time you change test kit lot numbers. 
• Any time the UA displays a recalibration message. 

 

 

CAUTION: 

• Each test kit comes with a calibration button marked with the sensor lot calibration 
code. Always make sure that the lot numbers on the sensor containers and 
calibration button match the “Sensor Lot #” on the analyzer display. 

• Do NOT use items from more than one test kit at a time. 

• Calibration is required for each new lot of sensors. Use only the calibration button 
packaged with the test kit you are using. Failure to use the correct calibration button 
could generate false results. 

 

http://www.magellandx.com/
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► Follow These Steps 

1. Power on the computer, monitor, and analyzer. The main “Windows” Login Screen will appear 
(Figure 4-1). 

 

Figure 4-1: The Main “Windows” Login Screen 

2. Select your user icon, type in your password, and press Enter. The LeadCare Ultra main screen 
(Figure 4-2) appears. After 20-30 seconds, the UA initializes the analyzer. 
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Figure 4-2: LeadCare Ultra UA Main Screen 

NOTES: • The first time you turn on the analyzer after installation, the “Calibration 
Required” dialog box appears: 

 
Figure 4-3: Calibration Required Screen 

• Once the system has been calibrated, the lot number of the calibration 
button is displayed in the upper left corner of the main screen  
(Sensor Lot #). 

• If the “Sensor Lot #” displayed does not match the kit lot number you 
intend to use, you must recalibrate the analyzer with the calibration 
button from the kit lot you intend to use. 
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3. Remove the calibration button from the test kit you are going to use. 

4. Hold the calibration button to the button reader until you hear the beep (see Figure 4-4). The 
button must touch both the center contact and metal side of the button reader. 

 

Figure 4-4: Holding Calibration Button to Button Reader 

5. Calibration can take up to 5 seconds. When calibration is complete, the analyzer beeps and the 
screen briefly displays a message stating that the analyzer was calibrated successfully  
(see Figure 4-5). 

 
Figure 4-5: Successful Calibration Message 

The Sensor Lot #: appears in the upper left corner of the main screen (see Figure 4-6). 
 

 
Figure 4-6: Sensor Lot # 

6. Once the calibration is successful, the “Quality Control Settings” dialog box displays.  
See Section 4.4, Entering Quality Control Settings, to proceed. 
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4.4 Entering Quality Control Settings 
Quality control information can be entered anytime. When calibrating the analyzer with a new button, 
the “Quality Control Settings” dialog box opens automatically (Figure 4-7). 

If the QC lot has expired, the associated expiration date in the “Quality Control Settings” dialog box will 
turn red, flagging you to update the QC information. 

 
NOTE: At any other time, to access the Quality Control Settings, click Tools > Set 

the QC Levels from the UA. 
 

► Follow These Steps 

1. Using the arrows, select the desired number of QC levels. You have the ability to enter up to 
three levels of quality control. 

 

Figure 4-7: New QC Lot Dialog Box 

 

2. Enter the information for the new QC lot in the appropriate box: 

a. Control Name: Defaults to “LEVEL 1, LEVEL 2”, etc., for each level. To rename, delete 
the default name and enter the new name in the field. 

b. Control Lot #: Enter the lot number in the field. 

c. Target Range: Enter the target value in the first field and the tolerance in the second 
field. For example, a control with a target value of 7.0 + 3.0 is entered as shown in 
Figure 4-8. 
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Figure 4-8: New QC Lot Dialog Box 

 
d. Expires: Enter the expiration date of the control in the field by updating the month, day, 

and year (for example, 4/23/2017), or click on the down arrow to the right of the field to 
use the calendar feature. 

3. Repeat this process for each control level. 

NOTE: The Target and Tolerance values for each successive level must be higher 
than those set for the lowest level, and the ranges set for each level should 
not overlap. 

 

NOTE: The Target and/or Tolerance values can be changed without creating a new 
QC lot code. However, this change affects the QC charts for the QC levels. 
For example, if the target and/or tolerance values are changed, the QC 
results before and after the change will be on separate QC charts. 

 

NOTE: The Target or Tolerance values for a QC lot may be slightly different for 
other sensor lots. 
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If target and/or tolerance values are to be changed while keeping the same QC Lot #: 

a. Select Tools > Set Quality Control Levels. 

b. Add a letter to the original Control Lot #. For instance, if the original Control Lot # was 
031507, type in 031507A. Then change the target and/or tolerance values  
(see Figures 4-9 & 4-10). 

 

Figure 4-9: Editing Original Control Lot Target Values 

 

Figure 4-10: Entering New Target Values 

4. Once all Quality Control Settings fields are updated, click the OK button. 

5. The “Confirm Quality Control Level Information” dialog box appears (Figure 4-11). Review the 
information and select Yes if the information is correct. If the information is not correct, select 
No. This returns you to the “Quality Control Settings” dialog box to make the necessary 
corrections. 

6. The LeadCare Ultra Blood Lead Testing System is now ready for testing (see Figure 4-12).  

Original 
Control Lot # 

Original Control 
Lot # with an “A” 
added to reflect 
new target values 

Original target 
values 

New target 
values 
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Figure 4-11: Confirm Quality Control Level Information Dialog Box 

 
Figure 4-12: LeadCare Ultra UA Ready for Sensors 
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4.5 Setting a Patient Test Limit (optional) 
The Set Patient Test Limit option allows you to flag a patient result that is above a user-specified level. 
Each laboratory should establish its own limits according to its Standard Operating Procedure (SOP). 

NOTE: Limits do NOT have to be set to run the LeadCare Ultra Blood Lead Testing 
System. 

 

► Follow These Steps 

1. Click Tools > Set the Patient Test Limits. The “Patient Test Limits” dialog box displays  
(Figure 4-13). 

2. Specify the number of test limits to be set (up to three). 

3. For each limit to be set, enter the name of the limit, the target lead concentration, and 
instructions to be displayed in the comment field when the limit is exceeded. If you are adding 
multiple target values, each successive target value must be larger than the previous target 
value. 

NOTE: Only one instruction per test result displays. 

 

4. Click the OK button when done. 

 
Figure 4-13: Patient Test Limits Dialog Box 
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5. The “Confirm Patient Test Limit Information” dialog box appears (Figure 4-14). 

 

Figure 4-14: Confirm Patient Test Limit Dialog Box  

 
6. Review the information and select Yes if the information is correct. If the information is not 

correct, select No. This returns you to the “Patient Test Limits” dialog box to make the 
necessary corrections. 

NOTE: If a blood lead result exceeds a limit entered, the typed instructions appear 
in the Comment field of the sample record on the main screen. 
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5 Performing Quality Control 
5.1 Introduction 
Quality controls are used to verify that the system and procedures in place are generating accurate 
results. 

NOTE: The LeadCare Ultra® Controls are for in vitro (external) use only. 

5.2 What are Blood Lead Controls? 
A control is a standard against which test results can be evaluated. The LeadCare Ultra Blood Lead 
Controls are buffered aqueous solutions containing bovine serum albumin and dye. These Quality 
Control (QC) solutions contain a known quantity of lead. To ensure that your patient test results are 
accurate, you must periodically run the LeadCare Ultra Control samples. 

Acceptable ranges for each lot and lead level are established by Magellan Diagnostics using the 
LeadCare Ultra Blood Lead Testing System. Magellan Diagnostics, Inc. establishes these ranges using 
extensive replicate analyses and rigid QC. 

CLIA guidelines recommend that a minimum of two levels of QC be performed with each analytical run. 
Two levels of QC are included in the LeadCare Ultra Test Kit. Each control has an assigned target 
range (target value +/- tolerance value). 

NOTES: • Any QC result which falls within the assigned target range for that specific QC 
Level and lot is determined to be “in range” and therefore, acceptable. 

• Any QC result which falls outside of the assigned target range for that specific QC 
Level and lot is determined to be “out of range” and therefore, unacceptable. 

• The QC results should be within range before patient samples are tested. 
 
 

http://www.magellandx.com/
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5.3 How Often Should You Test Controls? 
According to CLIA guidelines for Moderately Complex tests, a minimum of two levels of controls should 
be: 

• Tested each day or shift before patient samples are tested for lead concentration. 
• Prepared and tested by each analyst who prepares samples. 
• Run to test the technique of new users. 
• Run at any other time you wish to verify system performance. 

NOTE: Some certification programs may have additional QC requirements. Follow 
the applicable federal, state, and local guidelines to ensure compliance. 

 
For additional important information on QC, refer to the package insert provided with the test kit. 

5.4 Safety Precautions 
You must understand and follow these precautions when performing QC testing using the LeadCare 
Ultra Blood Lead Testing System. 
 

 

CAUTION: When performing QC testing: 

• Keep the sensors in their container and the container closed until you need them. 
The sensor vial contains a desiccant which controls the humidity. If the sensors are 
exposed to humidity for an extended period of time this could lead to a false test 
result. 

• Do NOT touch the “X” on the sensors, except when applying the control. This could 
cause contamination and a false test result. 

• Make sure the sensor is inserted under the sensor guides and sits flush on the 
sensor deck. Inserting the sensor above the guides could cause inaccurate test 
results. 

• Do NOT allow the inside of the treatment reagent vial or the vial cap to touch 
anything. This could cause false blood lead test results. 

• Mix the control with the treatment reagent thoroughly. Gently invert the tube 10 times 
to mix thoroughly. Avoid creating foam and air bubbles. 

• Do NOT leave the treatment reagent vial uncapped other than to add the control or 
remove the control/reagent solution. The tube and its contents could be 
contaminated, causing false test results. 

• Before placing the mixture on the sensor, make sure the “Load the Sample” message 
appears in the channel box. 

• Wear powder-free gloves to prevent lead contamination. Because there is lead in the 
environment, it is easy to contaminate controls, collection tubes, and test kit items. 
Contamination of the work environment can cause inaccurate blood lead test results. 
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• When testing controls, make sure that the result is within the acceptable range for 
each Control. DO NOT proceed to patient samples if the Control results are NOT 
within acceptable limits. Refer to the Troubleshooting section (Chapter 7) of this 
User's Guide, or call Product Support at 800-275-0102 to help you resolve the 
problem. 

 

5.5 Storing and Handling the Controls 
Store LeadCare Ultra Controls at room temperature.  

 

CAUTION:  

• The control expiration date is printed on the control label. Do NOT use the controls 
past the expiration date; expired controls could cause inaccurate test results.  

• Use controls only with sensors of the same lot number. Discard remaining control 
solutions when the sensors from the kit are gone. 

5.6 Control Procedure 
Use this procedure to perform a QC test to help ensure accurate blood lead testing results. 

The LeadCare Ultra Test Kit is supplied with two levels of QC, each representative of different levels of 
lead. Level 1 represents a lower lead concentration, while Level 2 represents a higher lead 
concentration. 

NOTE: To enter QC target values, see Section 4.4. 

 

NOTE: If you are using control material not included with the LeadCare Ultra Test 
Kit, prepare according to manufacturer’s instructions. Bring the controls to 
room temperature and thoroughly mix before following the instructions 
below. 

 

► Follow These Steps 

1. Label a fresh treatment reagent tube Level 1 Control. Invert the Level 1 Control vial 8-10 times 
at a minimum to ensure homogeneity of the control material. 

2. Remove the cap from the treatment reagent tube and place it face up on a clean gauze pad. Do 
NOT allow the inside of the cap to touch anything. This could cause false test results. 

3. Using a calibrated pipette, withdraw 50 µL of control material from the control vial. 

4. Dispense the entire 50 µL aliquot of control solution into the treatment reagent tube. 
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5. Replace the control vial cap and the treatment reagent tube cap. Mix the control/treatment 
reagent mixture by holding the tube horizontally and gently shaking until the entire inside walls 
are evenly coated with a reddish solution. 

6. Repeat this process (steps 1 through 7) for the Level 2 Control. 

7. Analyze both control samples according to the instructions provided in Chapter 6 (Step D: 
Analyze the Sample) on page 6-8. 

NOTE: Prior to testing, the LeadCare Ultra Level 1 and Level 2 Controls must be 
mixed with treatment reagent (50 µL of control into a fresh treatment 
reagent tube). Quality control samples can be prepared and analyzed 
immediately, or prepared with patient samples.  

 

5.7 Understanding the Quality Control Results 
Control target ranges are provided on the control label. If the control results are within the range listed 
for the control, your LeadCare Ultra System is working properly. 

If the reported control results are not within the listed range, refer to the Troubleshooting section in 
Chapter 7 of this guide or call Magellan Diagnostics Product Support at 800-275-0102. 

 

 

CAUTION: Do NOT proceed to testing patient samples unless all control level 
results are within the acceptable ranges. 

 

5.8 Viewing Quality Control Test Records 
The Quality Control Tests option displays a dialog box in which you can enter search criteria to search 
for and display all, or specific, quality control test records. It also contains an option that lets you view 
quality control charts, which provides a useful graphic of the selected QC data. 

► Follow These Steps 

1. To display quality control test records, click View > Quality Control Tests. The “Quality Control 
Test View” dialog box opens (Figure 5-1). 
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Figure 5-1: Quality Control Test View Dialog Box 

2. Use the mouse to select one of the following search (filter) criteria: 

a. Show all tests 
b. Filter records by specified values 

3. If you selected “Filter records by specified values” you can further refine your search by: 

a. QC Level 
b. QC Lot # 
c. Test Date Range  
d. Result Range 
e. Controls Out of Range 
f. Channel # 
g. Sensor Lot # 
h. User 
i. Comments 

4. Enter your search criteria and select the Apply Filter button. 

5. Select the View Report button in the lower right corner. 

6. The “Custom Report Header Information” screen opens (Figure 5-2). 
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Figure 5-2: Custom Report Header Information Screen 

7. Enter the desired report headers (Lines 2 and 3 are provided for multi-part headers), and click 
Done. 

8. Based on the search criteria, the quality control test results are filtered and those results  
that meet your search criteria are displayed. A sample “QC Test Report” is shown below in 
Figure 5-3. 

 
Figure 5-3: Sample Quality Control Test Report 

9. The Binoculars icon in the menu bar allows you to search the report for specific text. 

10. The Zoom icon in the menu bar allows you to increase the font size of the report. 

11. To print the report, click the Print icon in the menu bar, and then enter the desired print 
parameters in the standard Windows “Print” dialog box that appears. 
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5.8.1 Displaying Quality Control Charts 
Quality control charts allow you to view each result in comparison to the target value for any given lot 
number. 

► Follow These Steps 

1. To display quality control charts, click View > Quality Control Tests. The “Quality Control Test 
View” dialog box displays as shown in Figure 5-1. 

2. Use filters to choose which QC results to view as described in Section 5.8, (steps 2-4); then, 
click the View Charts button to generate graphs of the selected QC data.  

3. In the “Quality Control Chart Viewer”, a separate chart is created for each control level and 
sensor lot (see Figure 5-4). The description for each chart generated appears in a column on 
the left-hand side of the display. The chart displayed to the right corresponds to the highlighted 
chart description. 

 
Figure 5-4: Quality Control Charts 

4. To view a different chart, click on the chart description in the left column. 
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5. The “Sort by:” feature in the upper left corner allows you to sort the charts by: 

a. Level 

b. Lot Code (should be “QC Lot #”) 

c. Sensor Lot 

d. Month/Year 

6. The “Order:” feature sorts the charts in ascending or descending order. 

7. To print a quality control chart, click the Printer icon above the displayed chart, then enter the 
desired print parameters in the standard Windows “Print” dialog box that appears. 
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6 Performing Blood Lead Testing 
6.1 Introduction 
When your LeadCare Ultra® Blood Lead Testing System has been installed, calibrated, and had QC 
performed, blood lead tests can be conducted. This chapter describes how to test a patient’s blood for 
lead. It contains the following topics: 

• Specimen Requirements 
• Limitations of the Test 
• Overview of the Testing Procedure 
• Safety Precautions 
• Required Materials 
• Testing Procedure 
• Processing Blood Lead Test Results 
• Viewing and Printing Blood Lead Test Results 
• State Reporting of Blood Lead Test Results 
• Follow-up Testing 

 

 

WARNING: Read all instructions carefully before you perform a blood lead test. 
Failure to follow these instructions could result in injury from inaccurate results or 
injury to lab personnel. 

 

 

WARNING: Blood can transmit infectious diseases. Use universal precautions while 
collecting and handling blood samples. Follow the procedures set up by your institution 
for meeting federal, state, and local regulations. 

6.2 Specimen Requirements 
Capillary whole blood samples must be collected with an acceptable anticoagulant and stored properly 
before testing. 

6.2.1 Acceptable Anticoagulants and Collection Devices 
Acceptable anticoagulants for blood lead samples: 

• EDTA 

• Heparin 

http://www.magellandx.com/
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Acceptable collection devices for blood lead samples: 
• Capillary blood collection devices.  

6.2.2 Collection and Storage Conditions 
Capillary blood samples must be collected and stored properly in order for lead testing to be performed.  
Refer to the LeadCare Ultra Blood Lead Test Kit Package Insert for detailed requirements. 

 

CAUTION: Blood samples must meet the following standards in order to be tested 
for lead. Failure to observe these conditions may cause inaccurate results: 

• The whole blood sample must be free of blood clots. 

• When EDTA capillary blood collection devices are used for sample collection, 
the tube must be at least half full for the sample to be appropriate for use. 
EDTA in high concentrations can lower the blood lead value. Reject any sample 
less than half full. 

• Whole blood samples collected with EDTA or Heparin as anticoagulant must 
be: 

o Shipped and stored between 1°C - 25°C, 33°F - 77°F (refrigerated or 
room temperature conditions). 

o Mixed with treatment reagent within 72 hours from time of blood 
collection. 

• The whole blood sample must be brought to room temperature and thoroughly 
mixed prior to addition to treatment reagent. 

• The mixture of blood and Treatment Reagent is stable for up to 48 hours at 
room temperature and up to 7 days if you refrigerate it immediately.  

6.3 Limitations of the Test 
• Use only whole blood stored at 1°C - 25°C (33°F - 77°F) from collection up to 72 hours prior to 

being mixed with treatment reagent.  
• Do NOT use venous.  Do NOT use plasma or serum.  
• Use a calibrated pipet to transfer 50 µL of blood from the collection device into the treatment 

reagent tube. 
• Refer to the LeadCare Ultra Test Kit Package Insert for detailed instructions on sample storage 

and analysis.  

NOTE: Allow mixture to reach room temperature before analyzing 

• Extremes in humidity may affect the blood lead results. Performance has been validated from 
12% - 80% Relative Humidity (non-condensing). Use of the LeadCare Ultra System outside of 
this range is not recommended. 
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• Use the LeadCare Ultra System above altitudes of 8,000 feet has not been validated and is 
therefore not recommended. 

• Do NOT use the LeadCare Ultra System in drafts. This could lead to inaccurate results. 
• Keep the LeadCare Ultra System out of direct sunlight. 
• The analyzer will only function in the temperature range of 16°C - 30°C (60.8°F - 86°F). 

Otherwise the system will display a temperature error. Refer to error messages in the User’s 
Guide (Chapter 7).  

• Allow all of the LeadCare Ultra System components to reach a steady temperature before using. 
• Use the sensors and the treatment reagent tubes, only once. Do NOT reuse. Reuse could lead 

to erroneous results. 
• Do NOT use damaged (bent, scratched, cut, etc.) sensors. 

6.4 Overview of the Testing Procedure 
Testing for lead in blood with the LeadCare Ultra Blood Lead Testing System consists of the following 
steps. See Section 6.7 for detailed step-by-step procedures: 

1. Make sure you have the required materials. 

2. Use whole blood samples (capillary) collected with EDTA or Heparin anticoagulant. 

3. When EDTA capillary blood collection devices are used for sample collection, the tube must be 
at least half full for the sample to be appropriate for use. EDTA in high concentrations can 
lower the blood lead value. Reject any sample less than half full. 

4. Add 50 µL of a blood sample to a labeled treatment reagent tube, recap, and mix thoroughly. 
The sample preparation will turn brown. 

5. Match the sensor vial lot number with the displayed lot number and insert a sensor into the 
analyzer. 

6. Enter the Sample ID, either using the barcode scanner or by typing the entry on the keyboard. 

7. Remix the tube contents by inverting the tube before sampling. Draw 30 µL of the sample 
mixture with a pipette from the treatment reagent tube and dispense on the (X) on the sensor.  

8. The analyzer starts the 3-minute analysis automatically. Test results are displayed both in the 
appropriate channel box and in the data table field on the LeadCare Ultra UA main screen. 
Results are also saved to the hard drive along with all other pertinent Sample ID data, Analysis 
Comments, Operator ID, and Date and Time. 

6.5 Safety Precautions 
Observe the precautions listed throughout this section. Failure to follow these precautions may cause 
inaccurate results. Important precautions for testing are also listed in Chapter 1, Important Safety 
Information. 
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6.5.1 General Precautions 
Follow these safety precautions any time you are working with the LeadCare Ultra Blood Lead Testing 
System. 
 

 

WARNINGS: 
• Dispose of sensors, pipette tips, and other materials exposed to human blood 

in a biohazard container. 

• Use caution when handling the LeadCare Ultra Treatment Reagent. The 
reagent contains dilute HCl. Reagent vials and vial packaging are designed to 
minimize chances of leaks during shipping or under normal use. Refer to the 
LeadCare Ultra Treatment Reagent Safety Data Sheet that appears in 
Appendix C of this manual. 

 

 

CAUTIONS: 

• Do NOT use sensors that have been dropped, previously handled, broken, 
scratched, or damaged in any way. This could cause false test results. 

• Do NOT use any test kit or controls past the expiration date. This could cause 
false test results. 

• Do NOT leave the treatment reagent vial uncapped other than to add the 
sample or remove the sample/reagent solution. The tube and its contents could 
be contaminated, causing false test results. 

 

6.5.2 Precautions when Preparing Patient Samples 
You must understand and follow these precautions when preparing blood samples to be tested using 
the LeadCare Ultra Blood Lead Testing System. 
 

 

WARNING: Blood can transmit infectious diseases. Use universal precautions while 
collecting and handling blood samples. Follow the procedures set up by your institution 
for meeting federal, state, and local regulations. 

 

 

WARNING: Be careful when handling the LeadCare Ultra Treatment Reagent. The 
treatment reagent contains dilute HCl. Reagent vials and vial packaging are 
designed to minimize chances of leaks during shipping or under normal use. Refer 
to the LeadCare Ultra Treatment Reagent Safety Data Sheet that appears in 
Appendix C of this User’s Guide. 

 

 

CAUTION: When preparing blood samples for testing: 

• Wear powder-free gloves to prevent lead contamination. Because there is lead 
in the environment, it is easy to contaminate blood samples, collection tubes 
and test kit items. Contamination of the work environment can cause inaccurate 
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blood lead test results. 

• Whole blood samples must be mixed with an acceptable anticoagulant and 
stored properly before testing. Make sure the blood sample meets all specimen 
requirements detailed in the LeadCare Ultra Blood Lead Test Kit Package 
Insert.  

6.5.3 Precautions when Testing a Patient Sample 
You must understand and follow these precautions when using the LeadCare Ultra Blood Lead Testing 
System to test patient blood samples. 
 

 

CAUTION: When testing blood samples: 

• Keep the sensors in their container and the container closed until you need 
them. The sensor vial contains a desiccant which controls the humidity. 
Exposing the sensors to humidity for an extended period of time could lead to a 
false test result. 

• Do NOT touch the “X” on the sensors, except when applying the sample. This 
could cause contamination and a false test result. 

• Make sure the sensor is inserted under the sensor guides and sits flush on the 
sensor deck. Inserting the sensor above the guides could cause inaccurate test 
results. 

• Do NOT allow the inside of the treatment reagent vial or the vial cap to touch 
anything. This could cause false blood lead test results. 

• Mix the control with the treatment reagent thoroughly. Gently invert the tube 10 
times to mix thoroughly. Avoid creating foam and air bubbles. 

• Do NOT leave the treatment reagent vial uncapped other than to add the 
sample or remove the sample/reagent solution. The tube and its contents could 
be contaminated, causing false test results. 

• Before placing the sample on the sensor, make sure the “Load the Sample” 
message appears in the channel box. 

• Wear powder-free gloves to prevent lead contamination. Because there is lead 
in the environment, it is easy to contaminate blood samples, collection tubes, 
and test kit items. Contamination of the work environment can cause inaccurate 
blood lead test results. 
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6.6 Required Materials 
Have the following materials gathered before starting a blood lead test: 

• Protective gloves (powder-free) 
• Absorbent liner and biohazard waste container 
• LeadCare Ultra System 
• LeadCare Ultra User’s Guide 
• LeadCare Ultra Test Kit items  

o Treatment reagent tubes 
o Blood lead sensors 
o Calibration button 
o Package Insert 
o Two quality control samples 

6.7 Testing Procedure 
Perform a blood lead test by following Steps A-D, below. 

6.7.1 Step A: Gather Test Materials 
► Follow These Steps 

1. Place the following items in front of you in a clean work space: 

• LeadCare Ultra Blood Lead Testing System 

• LeadCare Ultra Blood Lead Test Kit, which includes: 
o Treatment reagent tubes 
o Sensor vials  
o Quality controls 
o Calibration button 

• 50 µL pipette and disposable pipette tips 

• 30 µL pipette and disposable pipette tips 

• Capillary blood samples 

 

CAUTION: Allow the analyzer, test kit, and samples to reach room temperature 
before testing. Operating outside the temperature range of 16°C - 30°C (61°F - 86°F) 
and 12% - 80% relative humidity, or in conditions of fluctuating temperature and 
humidity, may lead to inaccurate results.  

 
NOTE: Be sure the LeadCare Ultra Blood Lead Test Kit items all come from the same test 

kit. Do NOT mix items from different test kits. 
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6.7.2 Step B: Prepare the Sample 

 

CAUTION:  
• Add capillary blood sample to the treatment reagent within 72 hours of 

collection. Blood older than 72 hours may produce inaccurate results. 

• Use only capillary whole blood with the LeadCare Ultra Treatment Reagent. 
Blood may be stored at room temperature or refrigerated for up to 72 hours 
before use. The whole blood sample must be brought to room temperature and 
thoroughly mixed prior to addition to treatment reagent. 

• Make sure the blood sample is free of blood clots, which can cause inaccurate 
results. Make sure to dispense exactly 50 µL of blood into the treatment 
reagent. 

Please refer to the LeadCare Ultra Test Kit Package Insert for detailed instructions on preparing 
a sample.  
 
► Follow These Steps 

1. Bring the blood samples to room temperature and mix thoroughly. 

2. Label a treatment reagent tube with the Sample ID (or barcode label, if applicable). 

3. Remove the cap from the tube and place it face up on a clean gauze pad. 

4. Transfer 50 µL of the whole blood sample into the treatment reagent tube. 

5. Recap the tube, and invert a minimum of 8 to 10 times to mix the sample completely. 

6. Repeat steps 1 - 5 for each sample to be tested. 
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6.7.3 Step C: Turn the System ON 
► Follow These Steps 

1. Turn ON the analyzer and login to the LeadCare Ultra System. 

2. Check that the calibration code of the sensors in use matches the calibration code displayed on 
the main screen. Recalibrate if necessary. 

3. Enter Patient Test Limit, if desired. For details, see Section 4.5. 

 

6.7.4 Step D: Analyze the Sample 
► Follow These Steps 

1. Remove a sensor from one of the sensor vials by grasping the sensor at the end with the 
alphanumeric designation. 

2. Close the vial. 

 
Figure 6-1: UA Ready to Accept Sensors 

3. Insert a sensor (with the black bars facing up) completely into the analyzer. Make sure the 
sensor is inserted under the sensor guides and sits flush on the sensor deck. When the sensor 
is inserted properly, the analyzer beeps and displays the “Scan a Barcode” message shown in 
Figure 6-2. Insert as many sensors as needed, up to a maximum of six. 

 

 

CAUTION: Keep the sensors in their container until you are ready to use them. 
Minimize handling to prevent contamination which could cause a false test result. 
Ensure that the lot number on the sensor vial matches the lot number displayed on 
the monitor. 
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Figure 6-2: UA Waiting for Barcodes 

4. Enter a Sample ID, using either the barcode scanner or manual entry mode, for each sample to 
be tested. When this is completed, you are prompted to add the sample mixture to the sensor; 
the channel messages change to “Load the Sample” and the Sample ID information you just 
entered appears at the top of the main screen (see Figure 6-3). 

NOTE: Verify that the Sample ID displayed for the channel matches the Sample ID 
on the treatment reagent/blood preparation. 

 

NOTE: Editing Sample ID – You can edit a Sample ID BEFORE the analysis 
starts and while it is in progress. Once the analysis is complete, the 
Sample ID cannot be changed. To edit a Sample ID, right click on the 
Sample ID in the main data table (THIS TABLE IS CALLED “ALL TESTS”) 
of the user screen. Select Change Patient Sample ID and type in the new 
Sample ID in the field “New Sample ID”. Click OK. The new Sample ID will 
appear in the Sample ID box of the main data table. 

 

NOTE: Barcode Scanner Not Connected – The barcode scanner does not need 
to be connected to the system in order to use the LeadCare Ultra UA. The 
UA defaults to manual entry mode when the barcode scanner is not 
connected. Specifically, if the scanner is not connected when the UA starts, 
the “BAR CODE READER FAILED” message displays. Click OK in 
response. The UA can then be used to run samples; you enter Sample ID 
and other information manually via the keypad. 
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5. After assigning the Sample ID, select the Sample Type by clicking on the Capillary radio button. 

 
Figure 6-3: UA Waiting for Samples 

6. Remix sample/treatment reagent mixture, then pipet 30 µL onto the (X) on the sensor. Analysis 
begins automatically. 

 
Figure 6-4: UA Analyzing Samples 

7. The system shows a graphic of the analysis countdown as analysis proceeds, from 180 
seconds to 0 seconds. 

 
Figure 6-5: UA Analysis Complete 
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8. When analysis is complete, blood lead concentrations display in the channel boxes and in the 
main data table at the top of the screen. The results are reported in micrograms (µg) of lead 
(Pb) per deciliter (dL) of whole human blood. 

9. Remove the used sensors. 

NOTE: A warning beep will sound if the used sensors are not removed from 
the analyzer after 20 minutes. The beep will continue to sound until all 
of the used sensors are removed. 

 
10. Discard the materials in an appropriate biohazard container. 

11. Repeat steps 1-10 to analyze additional samples. 

12. View the test results. Blood lead levels in the “Results” column appear in the main data table. 
Results are reported in micrograms (µg) of lead (Pb) per deciliter (dL) of whole human blood. 
Results are displayed to one decimal place. The reportable range of the LeadCare Ultra is  
1.9 µg/dL to 65.0 µg/dL. Results lower than the limit of detection will be displayed as ‘<1.9’. 
Results higher than the analytical range will be displayed as ‘>65’. 

13. Process the test results by approving or archiving the data. See Section 6.8, Processing Blood 
Lead Test Results. All test results remain as “unapproved” until the “approval/archiving” process 
is performed by the user. 

14. See Sections 6.10 and 6.11 for state reporting and follow-up lead testing requirements. 

6.8 Processing Blood Lead Test Results 
All completed blood lead test results are listed in the main data table in the user screen (see Figure 6-6). 
These results remain on the main screen until they are either approved or archived. It is recommended 
that you approve or archive the blood lead results after all samples have been processed for the day.  
This way, the data table on the main screen can be cleared for the next day’s samples. 

Results can easily be viewed, sorted, and printed after either approving or archiving. Results remaining 
in the data table on the main screen can also be sorted and printed. 

NOTE: Sorting Results – You can sort results in the main data table by clicking 
on any column header. The default sort for “Results” is run order noted by 
test date and time in the “Test Date” Column of the main data table. 
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Figure 6-6: Approve & Archive Pop-up Menu 

 

NOTE: If power to the analyzer is turned OFF, you can still work with all the UA 
functions except performing new blood lead tests. 

 
 

6.8.1 Archiving Test Results 
Results in the main data table can be archived; whereby they will remain on the LeadCare Ultra Blood 
Lead Testing System indefinitely. If your LeadCare Ultra Blood Lead Testing System is NOT connected 
to an LIS, follow steps 1 and 2 to archive your results. 

 Archiving results achieves the following: 

1. Clears the results from the main data table (worklist). 

2. Places the results in the “Archived Test View”, an option available on the View menu.  

► Follow These Steps 

1. You can archive all test results or select specific results for archival: 

• To archive all test results, select a test in the main data table and then right click on the 
desired Sample ID. Select Archive All Test Results from the dialog box displayed. 

• To archive selected test results select the test results to be archived by holding down the 
Ctrl key, selecting the desired Sample ID(s) by right clicking on the desired Sample ID(s). 
Select Archive Selected Test Result(s) from the dialog box displayed. 

2. The “Confirm Archived Test(s)” dialog box (Figure 6-7) indicates the number of test results 
selected for archival. Click OK to archive the desired test(s). The results are now moved to the 
Archived Test View. 
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Figure 6-7: Archive Tests Dialog Box 

 

6.8.2 Approving Test Results 
Test results can be approved either from the main data table (worklist) or from the “Archived Test 
View”. If your LeadCare Ultra System is connected to an LIS, use the following steps, steps 1-3, to 
approve your test results and to make the results available for access by the LIS. 

► Follow These Steps 

1. You can approve all test results or select specific results for approval: 

• To approve all test results select a test in the main data table and then right click on the 
desired Sample ID. Select Approve All Test Results from the dialog box displayed. 

• To approve selected test results select the test results to be approved by holding down the 
Ctrl key, selecting the desired Sample ID(s) by right clicking on the desired Sample ID(s). 
Select Approve Selected Test Result(s) from the dialog box displayed. 

2. The “Confirm Approved Test(s)” dialog box (Figure 6-8) indicates the number of test results 
selected for approval. You are reminded that the results will be removed from the worklist; 
moved to a published location on disk; and a copy of the data is saved in the archived test 
location. 

3. Click OK to approve the desired test(s). 

 
Figure 6-8: Approve Tests Dialog Box 
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4. To re-send  results to the LIS after they have already been approved, go to the archived test 
view, select the results you want to re-send and right click. Click on “Send Selected Test (s) to 
LIS,” or “Send All Approved Test(s) to LIS” to re-send all previously approved results to the LIS. 

 

6.8.3 Voiding/Unvoiding a Test Result 
Test results may be voided or unvoided at any time. To void a test result, right-click on the Sample ID 
you wish to void in the test data table on the main UA screen, then select Void Test from the pop-up 
menu shown in Figure 6-9. 

 

Figure 6-9: Void Test Pop-Up Menu 

To unvoid a voided test result (Admins and/or User Accessible), right-click on the voided Sample ID you 
wish to unvoid in the main data table, then select Unvoid Test from the pop-up (Figure 6-10). 

 

Figure 6-10: Unvoid Test Pop-Up Menu 
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6.8.4 Editing Test Result Comments 
You may edit the “Comments” field for any test result by right-clicking on the desired Sample ID Next, 
select Edit Comments from the pop-up menu shown in Figure 6-11. Click in the “Edit Test Comments” 
box and type in your new comments as desired. Click OK to accept. 

 

Figure 6-11: Edit Test Comments Box 

NOTE: “Edit Test Comments” is also available for QC results.  
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6.9 Viewing and Printing Blood Lead Test Results 
You may view, search, and create reports for archived and approved blood lead test results stored on 
the computer. If you have a printer connected, you may print reports. 

► Follow These Steps 

1. To view blood lead test results, click View > Archived Tests. An “Archived Tests View” viewer 
displays all blood lead test results stored on the computer (see Figure 6-12). 

 
Figure 6-12: Archived Test View Dialog Box 

2. Use the mouse to select one of the following search (filter) criteria: 

a. Show all tests 

b. Filter tests by specified values 

3. If you selected “Filter records by specified values”, you can further refine your search by: 

a. Sample ID  
b. Test Date range  
c. Result range 
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d. Controls Out of Range 
e. Channel # 
f. Sensor Lot # 
g. User 
h. Approved 
i. Approver 
j. Comments 

4. Enter your search criteria and select the Apply Filter button. The data meeting your search 
criteria will appear on the right hand side of the “Archived Test View” window. 

5. To obtain a report of this data select the View Report button in the lower right hand corner of 
the screen. The “Custom Report Header Information” screen displays (Figure 6-13). 

 
Figure 6-13: Custom Report Header Information Screen 

6. Enter the desired report header on line 1 and then click Done. (Lines 2 and 3 are provided for 
multi-part headers). The specified report is displayed. A sample Archived Test Report is shown 
in Figure 6-14. 
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Figure 6-14: Archived Test Report 

7. The Binoculars icon in the menu bar allows you to search the report for specific text. 

8. The Zoom icon (magnifying glass) in the menu bar allows you to increase the font size of the 
report. 

9. To print the report, click the Print icon in the menu bar, and then enter the desired print 
parameters in the standard Windows “Print” dialog box that appears. 
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6.10 State Reporting of Lead Test Results 
Lead poisoning remains the number one environmental threat to children, and is a major health 
concern. Most states require that results be submitted to the state’s health department. Contact your 
state’s Childhood Lead Poisoning Prevention Program for the specific reporting guidelines that apply to 
your blood lead results. 

NOTE: Report all blood lead test results to the appropriate local, state, or federal agency. 

Additional questions can be directed to Magellan Diagnostics Product Support at 800-275-0102 or 
LeadCareSupport@magellandx.com. 

6.11 Follow-up Testing 
According to the US Centers for Disease Control (CDC), there is no known safe level of lead. Consult 
your local public health department and/or CDC recommendations for information on the management 
of blood lead levels. 
 
Blood lead test results should be shared with the patient’s physician for interpretation and to determine 
when retesting and follow-up care are necessary. A capillary blood sample that generates an elevated 
lead level should be run at a reference laboratory using a high complexity testing method. 
 
For the most current information regarding blood lead testing guidelines, please refer to the CDC’s 
website and specific regulations in your State. 
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7 Troubleshooting 
7.1 Introduction 
Several factors may contribute to inaccurate blood lead patient sample and control test results. This 
chapter provides steps you can take if you obtain unexpected patient blood lead or control test results. 
Also provided is a list of error messages you may encounter in the event a problem occurs during 
testing. Error definitions and possible remedies are provided in this section.  

7.2 Troubleshooting 
The following tables provide possible causes of and remedies for inaccurate test results or control 
results.  
 
Table 7-1: Results Below the Target Range or Expected Value 

Problem Area Check the Following 

Sample Type • CONTROLS: 
o Make sure the control lot being used is the same lot number of the 

sensors in the kit being used. 
• PATIENT SAMPLE: 

o Use only capillary whole human blood collected with EDTA or 
Heparin anticoagulant. Do NOT use venous. Do NOT use plasma 
or serum. 

o Use only capillary blood collection devices for whole blood sample 
collection 

o Make sure the sample is free of clots. 
o Make sure the sample is < 72 hours old and has been stored at 

room temperature or in the refrigerator. 
o Bring the sample to room temperature before use. 
o Make sure EDTA capillary blood collection devices are at least half 

full to be considered an acceptable sample. 

Sample Preparation • Use calibrated pipettes and pipette tips to transfer precisely 50 µL of 
control or blood sample into the treatment reagent tube. 

• Always add the control or blood sample to treatment reagent and mix 
thoroughly.  

Equipment Setup and 
Calibration  

• Check the expiration on the test kit box to make sure the test kit materials 
have not expired. 

• Make sure the analyzer is calibrated properly using the calibration button 
from the kit being used.  

• When processing controls, check to make sure the sensor lot number on 
the main screen matches the lot number of the calibration button for the 
test kit. 

http://www.magellandx.com/
http://www.magellandx.com/�
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Problem Area Check the Following 

Testing Conditions • Avoid operating the LeadCare Ultra System in drafts or outside the 
specified temperature range 16°C - 30°C (61°F - 86°F) and specified 
humidity range (12 - 80%, Relative Humidity). 

• Make sure that the system and the test kit are maintained at a constant 
temperature. If you move any part of the system from one place to 
another, wait for the analyzer and components to reach a stable 
temperature. 

User Technique • Make sure the control or blood sample and treatment reagent mixture is 
thoroughly mixed before placing onto the sensor. 

o A control in treatment reagent mixture will remain red after mixing. 
o A blood sample in treatment reagent will turn brown after mixing. 

• Make sure the sample mixture is at room temperature before placing onto 
the sensors.  

• Keep sensor vial closed. Remove sensors from vial only when ready to run 
samples. 

• Add 30 µL of the sample/treatment reagent or control/treatment reagent 
mixture to the sensor. 

• Do NOT touch the sensor while the analyzer is running a test. 
• Make sure the collection container is at least half full. 

 
Table 7-2: Results Above the Target Range or Expected Value 

Problem Area Check the Following 

Sample Type • CONTROLS:  
o Make sure the control lot being used is the same lot number of the 

sensors in the kit being used.  
• PATIENT BLOOD SAMPLE: 

o Use only capillary whole human blood collected with EDTA or 
Heparin anticoagulant. Do NOT use venous. Do NOT use plasma 
or serum.  

o Make sure the sample is free of clots. 
o Make sure the sample is < 72 hours old and has been stored at 

room temperature or in the refrigerator. 
o Bring the sample to room temperature before use. 
o Make sure EDTA capillary blood collection devices are at least half 

full to be considered an acceptable sample. 

Blood Sampling • Lead is widespread in the environment. It is easy to contaminate a blood 
sample. Ensure that the sample being tested came from a collection site 
that was thoroughly cleaned with soap and water followed by a clean 
alcohol wipe prior to capillary blood collection. 

• Use clean powder-free gloves during testing. 
• Use calibrated pipettes and pipette tips to transfer precisely 50 µL of 

control into the treatment reagent tube. 
• Make sure the pipette tip is filled properly. The accuracy of the test 

depends on filling the pipette tip with 50 µL. Excess blood on the outside of 
the pipette tip may produce higher blood lead test results. 
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Problem Area Check the Following 

Sample Preparation • Use clean powder-free gloves during testing and keep your gloved hands 
clean. 

• Use calibrated pipettes and pipette tips to transfer precisely 50 µL of 
control or blood sample into the treatment reagent tube. 

• Make sure the pipette tip is filled properly. The accuracy of the test 
depends on filling the pipette tip with 50 µL. Excess sample on the outside 
of the pipette tip may produce higher test results. 

• Always add the control or blood sample to treatment reagent and mix 
thoroughly.  

Equipment Setup and 
Calibration  

• Check the expiration on the test kit box to make sure the test kit materials 
have not expired. 

• Make sure the analyzer is calibrated properly. Use the calibration button 
that came with the test kit you are using.  

• When processing controls, check to make sure the code on the main 
screen matches the code of the calibration button for the test kit. 

Testing Conditions • Avoid operating the LeadCare Ultra System in drafts or outside the 
specified temperature range (16°C - 30°C / 61°F - 86°F) and specified 
humidity range (12 - 80%, Relative Humidity). 

• Make sure that the system and the test kit are maintained at a constant 
temperature. If you move any part of the system from one place to 
another, wait for the analyzer and components to reach a stable 
temperature. 

User Technique • Do NOT touch the black bars or the black cross on the sensor. This could 
damage or contaminate the sensor. 

• Do NOT touch the ends of the pipette tips. This could cause 
contamination. 

• When uncapping the treatment reagent tube, place cap, inside facing up, 
on a clean surface. 

• Do NOT leave the treatment reagent tube uncapped other than to add or 
remove sample to/from the treatment reagent tube. 

• Make sure the control or blood sample and treatment reagent mixture is 
thoroughly mixed before placing onto the sensor. 

o The control in treatment reagent mixture will remain red after 
mixing. 

o A blood sample in treatment reagent will turn brown after mixing. 
• Make sure the sample mixture is at room temperature before placing onto 

the sensors. 
• Keep sensor vial closed. Remove sensors from vial only when ready to run 

samples.  
• If you drop a sensor, do NOT use it. 
• Make sure 30 µL of the sample/treatment reagent or control/treatment 

reagent mixture is added to the sensor. 
• Do NOT touch the sensor while the analyzer is running a test. 
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7.3 Summary of Display Messages 
Normally, only five messages are displayed during the test process:  

• ”INSERT A SENSOR” 

• “SCAN A BARCODE” 

• “LOAD THE SAMPLE” 

• “ANALYZING THE SAMPLE” 

• “RESULT” 

However, other messages may appear if the analyzer detects a condition that prevents normal 
operation. Table 7-3 shows the possible display messages. 

 

Table 7-3: UA Error Messages 

Error Type/Message Reason(s) Fix 

System Errors   

Analyzer Connection to Computer Workstation 

 
 

• The analyzer is turned 
OFF when UA is open. 

• The analyzer is 
disconnected from 
power source when 
UA is open 

• The analyzer is not 
connected to the 
computer workstation 
by the USB cable. 

 

• Confirm the power 
switch on the back of 
the analyzer is set to 
the ON position. 

• Confirm the power 
socket/outlet 
connection to the 
analyzer power 
supply is set to the 
ON position. 

• Confirm that the 
analyzer is connected 
to the computer via 
the USB cable. 
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Error Type/Message Reason(s) Fix 

Barcode Scanner Failed 

 

• Upon starting the UA, 
the barcode scanner 
was not detected.  

• The barcode scanner 
is not configured 
correctly. 

• Click Cancel button 
• Make sure the 

barcode scanner is 
connected to a USB 
port on the computer 
and that the green 
LED on the barcode 
scanner is lit. Make 
sure the computer is 
ON. 

• Restart the UA. Scan 
the barcode below. 
The scanner makes 
three rapid “beeps”.  

Calibrating Analyzer 

 

• Analyzer cannot be 
used until it is 
calibrated with a valid 
calibration button.  

 

• Calibrate the analyzer 
with a valid calibration 
button. 

Channel Locked 

 

• Internal check of the 
channel failed. 

• Remove sensor, turn 
analyzer OFF, then 
turn analyzer ON. 
Wait ~10 seconds for 
the UA to initialize the 
analyzer. Insert a new 
sensor.  

• If the error continues, 
call Product Support. 
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Error Type/Message Reason(s) Fix 

Analyzer Not Operational 

 
 

• Hardware or low level 
firmware malfunction 
of the analyzer. 

• Call Product Support. 

System Not Operational 

 

• Files on data drive are 
missing or incomplete. 

• Files on data drive not 
protected. 

• Call Product Support. 

Temperature Below Limit or Temperature Above 
Limit 

 

• The temperature of the 
analyzer is outside of 
its operational 
temperature range. 

• Place the system in 
an environment of 
ambient temperature 
16°C to 30°C. Allow 
the analyzer to adjust 
to ambient 
temperature. 

Analyzer Calibration Failed 

 

 

• The analyzer failed to 
calibrate. 

o Button did not make 
sufficient contact in 
button reader port 

o Defective calibration 
button 

• Attempt to re-calibrate 
using the calibration 
button. 

• If the error continues, 
call Magellan Product 
Support. 
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Error Type/Message Reason(s) Fix 

Process Errors   

Sensor Lot Expired 

 

• The expiration date for 
the sensor lot has 
passed. 

• The expiration date for 
the test kit has passed.  

• Discard the expired 
test kit. 

QC Lot Expired 

 

• The expiration date for 
the QC lot was input 
incorrectly. 

• The expiration date for 
the QC lot has passed. 

• QC information was 
never entered. 

• Confirm the QC Lot 
expiration date was 
input correctly. 

• If the QC Lot has 
expired, discard the 
material. 

No Sample ID 

 

• Sample ID must be 
entered into the UA 
before testing a 
sample. 

• A Sample ID was not 
entered before putting 
the sample on the 
sensor. Remove and 
discard the sensor, 
insert a fresh sensor 
and enter the Sample 
ID before adding 
sample to the sensor. 

Temperature is Unstable During Blood Lead Test 

 

• The ambient 
temperature around 
the analyzer changed 
too much to perform 
the test. 

• Move the analyzer 
away from drafty 
area. Allow the 
analyzer to adjust to 
the ambient 
temperature. 
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Error Type/Message Reason(s) Fix 

Temperature Below Limit or Temperature Above 
Limit During Blood Lead Test 

 

• The temperature of the 
analyzer is outside of 
its operational 
temperature range. 

• Place the system in 
an environment of 
ambient temperature 
16°C - 30°C. Allow 
the analyzer to adjust 
to ambient 
temperature. 

Sensor Out of Vial Too Long 

 

• Sensor was left in the 
analyzer for more than 
five (5) minutes  
without use. Sensor 
performance may be 
compromised. 

• Remove and discard 
sensor. Insert a fresh 
sensor, enter Sample 
ID and add sample to 
sensor without delay. 

Sensor Inserted Before Ready 

 

• One or more sensors 
were detected in the 
analyzer as the 
analyzer was turned 
ON. 

• Remove and re-insert 
sensor. If the error 
continues, call 
Magellan Product 
Support. 

 

Sensor(s) Inserted on Exit 

 

• One or more sensors 
were detected in the 
analyzer as the 
analyzer was turned 
OFF. 

• Remove and discard 
sensors. 



LeadCare Ultra® Blood Lead Testing System User’s Guide 7-9 

Error Type/Message Reason(s) Fix 

Sensor Removed 

 

• A sensor was removed 
before sample analysis 
was complete. 

• Discard the sensor. 
Insert a new sensor 
and repeat the test. 
Allow the test to 
complete before 
removing the sensor. 

Used Sensor 

 

• A used sensor was 
inserted into the 
analyzer. 

• Remove and discard 
the used sensor. 

Sensor(s) Not Removed from Analyzer 

 

• Sensors are left in the 
analyzer for too long 
after analysis. 

• Remove and discard 
the sensors. 

• Do NOT leave 
sensors in the 
analyzer. 

Test Failed – Insufficient Sample Volume 

 

• Not enough sample 
was put on the sensor 
to start the test. 

 

• Remove and discard 
sensor. 

• Confirm pipette 
delivers at least 30 µL. 

• Repeat test, verifying 
sample fills the 
channel on the 
sensor. 
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Error Type/Message Reason(s) Fix 

Sensor Error 

 

• Analyzer detects a 
problem with the 
sensor. 

• Remove and discard 
the sensor. Repeat 
the test. 

• If the error persists 
call Magellan Product 
Support. 

Test Aborted 

 

• A problem was 
detected during 
analysis. The test was 
terminated. 

• Remove and discard 
the sensor. Repeat 
the test. 

• If the error persists 
call Magellan Product 
Support. 

 

7.4 Calling Magellan Diagnostics Product Support 
After troubleshooting, if you are unable to resolve your issue, contact Magellan Diagnostics Product 
Support at 800-275-0102 or LeadCareSupport@magallendx.com. 

Please write down this information and have it ready before you call: 

• Serial Number of Analyzer (on bottom of Analyzer and under Help > About) 
• Installation Date 
• Application Version Number (under Help > About) 
• Firmware Version Number (under Help > About) 
• Test Kit Lot # (on end of box) 
• Calibration Code on Calibration Button 
• Did you test with Controls?    Yes    No 

o If yes, were they LeadCare Ultra Controls?    Yes    No 
• Control Results Last Recorded (Level 1, Level 2): 
• Control Lot #: 
• Control Expiration Date 
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8 Performing Other Tasks 
This section describes how to perform a number of common tasks on the LeadCare Ultra® UA. These 
tasks can be performed by the system administrator or an operator.  

8.1 Viewing Calibration History 
The Calibration History option displays a dialog box in which you enter search criteria to search for and 
display calibration records.  

► Follow These Steps 

1. To display calibration records, click View > Calibration History. The “Calibration History” dialog 
box (Figure 8-1) displays, showing calibration records identified by Calibration Date & Time, 
Calibration Expires, Sensor Lot #, and User. 

 
Figure 8-1: Calibration History Dialog Box 
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2. Use the mouse to select the search criteria from the following choices: 

a. Show all calibration records. 

b. Filter calibration records by specified values. 

3. If you select the second search option, you can further refine your search criteria by “Date-From-To” 
range, “Sensor Lot #”, and “User”. Enter your search criteria and click the View Report button. The 
Custom Report Header Information screen displays (Figure 8-2). 

 
Figure 8-2: Custom Report Header Information Screen 

4. Enter the desired report header on line 1. Lines 2 and 3 are provided for if you have more lines of 
header information. 

5. Once all of the desired information has been entered, click Done. 

Based on your search criteria, the calibration records are filtered and those results that meet your 
search criteria display in the viewer. A sample Calibration History Report is shown in Figure 8-3. 

 
Figure 8-3: Sample Calibration History Report  

6. Click the Zoom icon in the menu bar to zoom in on (magnify) the results for a specific calibration 
record; click the Binoculars icon in the menu bar to search the results for a specific calibration 
record. 

7. To print the report, click the Print icon in the menu bar, and then enter the desired print parameters 
in the standard Windows “Print” dialog box that appears. 
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8.2 Viewing Error History 
Use the Error History option to search for and display error records. 

► Follow These Steps 

1. To display error records, click View >Error History. 

The “View Error History” dialog box can display error records such as: 
• Error 
• Error Type 
• Code 
• Channel 
• Date of Error 
• Channel # 
• Locked 
• Sensor Lot # 
• User 

 

 

Figure 8-4: Error History View Dialog Box 

2. Use the mouse to select one of the following search (filter) criteria: 

a. Show all records 
b. Filter records by specified values 
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3. The “Filter records by specified values” tabs option will allow you to refine your search according 
to the types of error records mentioned on the previous page. 

4. Enter your search criteria and select the Apply Filter button. The data meeting your search 
criteria will appear on the right hand side of the “View Error History” window. 

5. To obtain a report of this data select the View Report button in the lower right hand corner of 
the screen. The Custom Report Header Information screen displays (Figure 8-5). 

6. Enter your search criteria and click the View Report button. The Custom Report Header 
Information screen displays (Figure 8-5). 

 
Figure 8-5: Custom Report Header Information Screen 

7. Enter the desired report header on line 1 and then click Done. (Lines 2 and 3 are provided for 
multi-part headers. If you have more lines of header information go ahead and enter them. If 
not, click Done.) 

If entering the report for troubleshooting purposes, please enter: 
Line 1: Organization name 
Line 2: Problem description 

8. The specified report is displayed. A sample Error History Report is shown in Figure 8-6. 



LeadCare Ultra® Blood Lead Testing System User’s Guide 8-5 

 

Figure 8-6: Sample Error History Report 

8. Click the Zoom icon in the menu bar to zoom in on the results for a specific error record; click 
the Binoculars icon in the menu bar to search the results for a specific error record. 

9. To print the report, click the Print icon in the menu bar, and then enter the desired print 
parameters in the standard Windows “Print” dialog box that appears. 

8.3 Viewing User Login History 
The User Login History option displays a dialog box in which you enter search criteria to search for and 
display user login records.  

► Follow These Steps 

1. To display user login records, click View > User Login History. The “User Login History” dialog 
box displays (Figure 8-7), showing user login records identified by User Name, User Type, Logged 
In On, and Logged Out On. 
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Figure 8-7: User Login History Dialog Box 

2. Use the mouse to select the search criteria from the following choices: 

a. Show all user login records. 

b. Filter user login records by specified values. 

3. If you select the second search option, you can further refine your search criteria by Date-From-To 
range, User Name and User Type. Enter your search criteria and click the View Report button. The 
Custom Report Header Information screen displays (Figure 8-8). 

 
Figure 8-8: Custom Report Header Information Screen 
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4. Enter the desired report header on line 1. Lines 2 and 3 are provided for additional lines of header 
information. 

5. Once all of the desired information has been entered, click Done. 

Based on your search criteria, the user login records are filtered and those results that meet your 
search criteria display in the viewer. A sample user login history report is shown in Figure 8-9. 

 
Figure 8-9: Sample User Login History Report  

6. Click the Zoom icon in the menu bar to zoom in on (magnify) the results for a specific user login 
record; click the Binoculars icon in the menu bar to search the results for a specific user login. 

7. To print the report, click the Print icon in the menu bar, and then enter the desired print parameters 
in the standard Windows “Print” dialog box that appears. 

8.4 Creating User Accounts 
The Laboratory Manager or another laboratory designee with “Account Manager” privileges may assign 
or delete accounts, as well as change user passwords for the LeadCare Ultra software. If you are 
setting up the LeadCare Ultra System without the help of a Magellan Diagnostic Representative, 
or if you want to add or change User Accounts, please follow the steps below. 

► Follow These Steps 

1. Power on the computer, monitor, and analyzer. The main login screen will appear. 
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Figure 8-10: Main Login Screen 

2. Select the Account Manager User icon, type in the password, and press Enter. 

The LeadCare Ultra User Account Manager dialogue box appears, containing a chart with User 
Name, User Type, and Description fields (see Figure 8-11).  

NOTE: A password list will be provided by a Magellan Diagnostics Representative. 
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Figure 8-11: Account Manager Dialog Box 

NOTE: The LeadCare Ultra User Account Manager has five pre-defined 
Administrator fields and fifteen pre-defined Operator fields. 

 
3. Select an appropriate New User, either an Operator or an Administrator. When the field is 

selected it will be highlighted and the “Assign User” field will become active. 

4. Enter the information for User Name; Password; Confirm Password; and Description. “User 
Type” is pre-defined. Then click OK. 

5. Click on Apply to save changes. 

NOTE: Once a password is set it can be changed by logging into the Account 
Manager, selecting the appropriate User Name, and selecting the Change 
Password button. Type in the new password in the Change Password field. 
Confirm the password and click OK. 

 

 



LeadCare Ultra® Blood Lead Testing System User’s Guide 8-10 

8.5 LIS Interface 
The Ultra User Application provides the capability to transmit approved patient test results using the 
HL7 v2.5.1 standard. The LIS initiates the connection over TCP/IP on a specified port. Valid ports range 
from 1 – 65535. Once the connection has been established, the Ultra User Application will transmit all 
approved results per the format detailed in the document titled Connectivity to LIS.  

NOTE: Refer to the Connectivity to LIS document for LeadCare Ultra which 
describes how data is transmitted between the Ultra application and an 
external system such as LIS. If you need this document, please contact 
Product Support.  

 

To configure the parameters in the Ultra User App go to Tools > LIS > Settings 

• In the LIS Configuration Box that opens (Figure 8-12), check the Enable LIS Interface option. 

• Enter the TCP port to be used for transfer of results. Valid ports range from1 – 65535. 

• Click the Save button. 

NOTE: The Ultra User Application MUST BE RESTARTED if one of the 
parameters has been modified. 

 

NOTE: Only Admin accounts have the privileges to modify the LIS settings. All User 
accounts can view the settings. 

 

 

Figure 8-12: LIS Configuration 
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To View the status of the connection in the Ultra User App select Tools > LIS > Status. 

The LIS Interface Status box will open and display (Figure 8-13): 

• Current status of the connection between the Ultra and the LIS. 
• IP Address assigned to the LeadCare Ultra computer. 
• TCP Port. 
• Status of the pending Queue. 

 

Figure 8-13: LIS Interface Status 
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The Ultra User Application maintains a persistent queue of approved results to account for loss of 
connection or power outages. Results are removed from the queue once the LIS acknowledges receipt 
of the result. If for any reason a result cannot be transmitted or is rejected by the LIS, the result will 
remain in the queue. 

The queue contents can be cleared by clicking the Clear Queue button (Admin only). 

The LIS Interface Status box can be closed by clicking OK button. 
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9 Maintaining Test Results 
The LeadCare Ultra® UA contains both Backup and Restore features for use with writeable and  
re-writeable CD/DVD media. These features can be used to: 

• Back-up data to writeable CD/DVD type media. 
• Restore previously backed up data from a CD/DVD type media onto the LeadCare Ultra UA. 

These features are only available to Users with Administrator access credentials. They can be 
accessed by selecting: 

• Tools > Backup 
• Tools > Restore 

9.1 Backing Up Blood Lead Sample Test Results 
There are two types of backup processes available to the User: 

• A Simple Backup – Backing up of data to a blank CD/DVD media. 
• An Over-Write Backup – Backing up of data to a re-writeable CD/DVD media, used previously to 

back-up data.  
o The Over-Write backup operation will simply save the data files over the old ones  

(the CD is updated). 

NOTE: Please be advised when performing an Over-Write Backup: 
• A second set of data is not saved. 
• Merging of the two sets of data is not performed. 

 

NOTE: The Backup process DOES NOT remove any information from the system. 
It simply saves the information to the CD/DVD. 

 
If laboratory protocol requires maintaining a record of the daily test results, a new CD/DVD should be 
used each time the Backup feature is used. 

The Backup function can be accessed by selecting Tools > Backup. 

The “Confirm Backup Operation” dialog box (Figure 9-1) will appear on the screen to guide you through 
the process. 
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Figure 9-1: Confirm Backup Operation Dialog Box 

Upon completion of the backup process, the following notification will appear on the screen (Figure 9-2) 
and the CD/DVD will be automatically ejected.  

 

Figure 9-2: Backup Successful Dialog Box 

9.2 Restoring Blood Lead Sample Test Results 
In the event of a system failure resulting in loss of information, there are two “Restore” processes 
available which enable the User to reload historical information onto the system: 

• A Simple Restore – Restoring data onto a blank/empty LeadCare Ultra system. 
• A Merge Restore – Restoring data onto a LeadCare Ultra system already containing data. 

The Restore process places previously backed-up information, onto the LeadCare Ultra System: 

• The software has been designed to perform "checks" on the current information on the UA 
against the information being restored to the system. 

• If the information on the UA has been changed since the time of backup, the more current 
information will remain on the system – the restore will not "over write" these updates. 
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Table 9-1: Examples of Maintaining Updated Information During Merge Restore 

 Situation Outcome 

1 An unapproved record is backed up and 
then subsequently approved or archived 
within the UA (where the approved 
results are still present within the 
Archived View, for non-LIMS users). 

The approved and/or archived record present 
within the UA record will be maintained and 
applied. The original unapproved record 
present in the backup will not be applied to the 
Unapproved Tests. (UltraSampleRecords.xml 
file) 

2 A record has been backed-up and then 
subsequently edited within the UA. 
Editing functions are restricted to: 

• Editing a comment 

• Changing the sample type 

The comment and/or sample type present 
within the UA record will be maintained and 
applied. 

3 A voided record has been backed up and 
then subsequently un-voided within the 
UA. 

The un-voided record present within the UA 
records will be maintained and applied. 

4 An un-voided record has been backed up 
and then subsequently voided within the 
UA. 

The voided record present within the UA 
records will be maintained and applied. 

5 Limit files information is backed up and 
then subsequently updated (such as 
through recalibration) within the UA. 

The limit files information present within the UA 
shall be maintained and applied. 

 

The Restore function can be accessed by selecting Tools > Restore. 

The “Confirm Restore Operation” dialog box (Figure 9-3) will appear on the screen to guide the user 
through the Restore process: 

 

Figure 9-3: Confirm Restore Operation Dialog Box 
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Upon completion of the Restore process, the following notification will appear on the screen and the 
CD/DVD will be automatically ejected: 

 

Figure 9-4: Restore Successful Dialog Box 
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10 Maintenance 
For optimum performance, the LeadCare Ultra® Blood Lead Testing System must be properly 
maintained. This chapter contains maintenance procedures that should be performed on a regular 
basis. 

NOTE: Maintenance activities relating to the analyzer do NOT require the analyzer 
enclosure to be opened. 
There are no user serviceable parts inside the LeadCare Ultra Analyzer. 

 

10.1 Cleaning Procedures 
10.1.1 Cleaning the Analyzer 
The exterior case of the analyzer can be cleaned using a lint-free cloth dampened with a 10% bleach 
solution. 

• Do NOT clean the sensor connector (gold pins) present inside the analyzer channels. In the 
case of accidental spill, dry the area immediately. 

• Do NOT leave any residual liquid on the analyzer. 

• Do NOT wash the inside of the calibration button reader. 

10.1.2 Cleaning the Barcode Scanner 
The window of the barcode scanner should be cleaned periodically to assure scanning accuracy.  
Do NOT allow any abrasive material to touch the window. 

• Remove any dirt particles with a damp cloth. 

• Wipe the window using a lint-free cloth moistened with ammonia/water. 

• Do NOT spray water or other cleaning liquids directly into the window. 

10.1.3 Cleaning the Keyboard 
The keyboard should be thoroughly cleaned and disinfected on a regular basis. 

• Unplug the keyboard and clean the surface by lightly spraying, wiping or gently brushing. 

• Use only cloth rags, sponges or soft bristle brushes. 

• The manufacturer’s recommended disinfectants include: 

o Alcohol based cleaning products 

o Phenol based cleaning products 
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o Chlorine based cleaning products 

o 10% bleach 

o 70% Isopropyl alcohol solution 

o Disinfectant wipes 

• Blood products can remain on the disinfected areas after use of these products. If there is the 
possibility of blood contamination, you should remove all blood traces and ensure that blood-
borne diseases are eliminated; cleaning with a 10% solution of bleach is required. (Freshly 
prepare a 10% solution of household bleach, using 1 part bleach and 9 parts water, or add ½ 
cup bleach to 1 quart water.) 

• It is best to use a cotton swab to massage the bleach solution between the keys of the 
keyboard. 

10.1.4 Cleaning Other System Components 
Follow the manufacturer’s instructions to clean the exterior surfaces of the computer screen and 
mouse. 
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11 Reordering Information 
Ordering replacement parts for your LeadCare Ultra® Blood Lead Testing System is simple. If you know 
the item number, please contact our Customer Service Department at 800-959-5095 to complete your 
order.  

If you are unsure of the item number, or for a complete list of parts, please visit 
https://www.magellandx.com/leadcare-products/leadcare-ultra/support/parts-service/. 
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12 Technical Service Information 
12.1 Technical Service Policy 
To contact Magellan Diagnostics Product Support Department, call 800-275-0102 Monday through 
Friday, or email LeadCareSupport@magellandx.com. A Product Support Specialist is available from 
8:00 a.m. to 6:00 p.m. (EST) for you to: 

• Request technical assistance. 
• Request product and procedure training. 
• Report a problem. 
• Return products. 

 
Please contact our Customer Service Department directly at 1-800-959-5095 to: 

• Place an order. 
• Track a shipment. 
• Determine availability. 
• Check on installation. 

 

12.2  Preparing for a Technical Service Call 
Before you make a technical service call, be sure to obtain the following information, as appropriate, to 
submit with your request or question: 

• System version number. In the UA, select Help > About LeadCare Ultra, to display this 
information. 

• Serial number of the analyzer. 
• Test kit lot number. 
• The name and contact telephone number of the person who asked the question or 

detected the problem. This allows us to contact the person if we need more information, and to 
notify the person when an answer or correction is ready. If limited hours of contact are available, 
please include suggested contact times. 

• The date and time the problem was detected. This is not required for a simple question, but 
may be important in the case of a problem report. 
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• A question or description of the problem. When reporting a problem, the description should 
include: 

• What happened? 
• What did you expect to have happen? 
• What is the sensor lot number in use?  
• Did you find a work-around you can use until the problem is resolved? 
• Have you had this problem before? 

• Steps to reproduce the problem. THIS IS VERY IMPORTANT. Not having this information 
may mean that the problem cannot be corrected. It allows us to detect and reproduce the 
problem so that we can (a) determine which product versions are affected, (b) identify the 
problem and find its cause, and (c) verify that the problem is actually corrected when the 
correction work is done. 

• The date of the installation. How long has the system been installed? Has the software been 
updated? 

• You should include any other information that you think is important. 
• If you are submitting the request by fax, please write the information LEGIBLY in dark ink 

on light paper or type it. Do not use yellow pad paper or a pencil because the fax may not be 
legible when we receive it. 

• If you are reporting a problem that you have experienced before, please have your case number 
available. 

 
Product Support 

800-275-0102 
LeadCareSupport@magellandx.com 
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13 Returns 
A Return Materials Authorization (RMA) number must be issued by Magellan Diagnostics Product 
Support and clearly attached to the product before it is returned. 

1. Within the warranty period any part of the goods that prove to be defective in material or 
workmanship may be repaired or replaced on an exchange basis with a new or functionally 
operative part free of charge. 

2. After such warranty period, any labor, transportation, and subsistence expense shall be borne 
by the Buyer. If preferred, Buyer may return goods to Magellan Diagnostics with shipment both 
ways at Buyer’s expense for repair work. 

3. Parts returned damaged due to poor or insufficient packaging by the Buyer will not be accepted 
for service unless otherwise agreed. 

4. Any time parts are returned where no problems are found, a service/handling charge, which will 
reflect the labor to test and verify the parts as well as other incurred expenses, will be borne by 
the Buyer. 

5. In no event shall Magellan Diagnostics be liable for incidental or consequential damages, 
including, but not limited to, costs, or removal and reinstallation of such goods, good will, 
overhead expenses, loss of profit, and loss of use. 

6. The remedies are available only to the original Buyer. Buyer agrees to accept billing for service 
expense for service call resulting from other than a Magellan Diagnostics goods failure or other 
Magellan Diagnostics fault. 
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14 LeadCare Ultra Blood Lead 
Testing System Limited Warranty 

IMPORTANT – READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS. BY INSTALLING AND 
USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT: 

Magellan Diagnostics, Inc. (“Seller”) hereby sells the LeadCare Ultra® Blood Lead Testing System (the “System”) 
to you (“Buyer”), and Buyer purchases the System on the following terms and conditions: 
 

a. Seller warrants to Buyer that the following components of the System will materially conform to the specifications 
set forth in this User’s Guide and be free from defects in material and workmanship in normal use for one year from 
the date of delivery to Buyer as the original purchaser: analyzer, flat-screen monitor, computer, software, barcode 
scanner, keyboard. This warranty does not cover, and no warranty is provided for, anything else, including without 
limitation elements of the test kit, consumables and parts that by their nature are normally required to be replaced 
periodically consistent with normal maintenance. If any product covered by this warranty is returned to the original 
shipping point, transportation charges prepaid, within the applicable warranty period set forth above and upon 
examination Seller determines to its satisfaction that such component did not materially conform to the 
specifications set forth in this User’s Guide or was defective in material or workmanship, Seller will, at its option, 
repair or replace the component or the defective part thereof or refund the original purchase price of the component. 
The foregoing notwithstanding, Seller will not be responsible for and the foregoing warranties will not apply to 
damage to or defect in any component of the System resulting from misuse, negligence, accident, each whether in 
transit or at Buyer’s place of operations, failure to use, maintain or calibrate the System or component thereof in a 
manner consistent with the User’s Guide, exposure of the System to environmental conditions beyond those 
specified by the documentation, or repairs, alterations or installation made by any person or firm not duly authorized 
by Seller in writing this warranty shall be void. EXCEPT AS EXPRESSLY STATED IN PARAGRAPH A, ABOVE, 
SELLER EXPRESSLY DISCLAIMS ANY AND ALL REPRESENTATIONS AND WARRANTIES, EXPRESS OR 
IMPLIED, BY OPERATION OF LAW OR OTHERWISE, REGARDING OR RELATING TO THE SYSTEM OR ANY 
COMPONENTS THEREOF. SELLER SPECIFICALLY DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING 
WITHOUT LIMITATION ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE (IRRESPECTIVE OF ANY PREVIOUS COURSE OF DEALING BETWEEN THE PARTIES OR 
CUSTOM OR USAGE OF TRADE) OR RESULTS TO BE DERIVED FROM USE OF THE SYSTEM OR ANY 
COMPONENTS THEREOF OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS. 
NO REPRESENTATION OR OTHER AFFIRMATION OF FACT, INCLUDING WITHOUT LIMITATION 
STATEMENTS REGARDING CAPACITY, SUITABILITY OF USE OR PERFORMANCE OF THIS SYSTEM OR 
COMPONENTS THEREOF, WHETHER MADE BY SELLER EMPLOYEES OR OTHERWISE, WHICH IS NOT SET 
FORTH ABOVE IN THIS PARAGRAPH , SHALL BE DEEMED A WARRANTY BY SELLER FOR ANY PURPOSE 
OR GIVE RISE TO ANY LIABILITY OF SELLER WHATSOEVER. BUYER’S EXCLUSIVE REMEDIES AND 
SELLER’S SOLE LIABILITY FOR ANY NON-CONFORMITY OR DEFECT IN THE SYSTEM WILL BE THOSE 
EXPRESSED HEREIN. 

b. Seller does not warrant that the operation of the System will be uninterrupted or error free. The System is not 
designed, manufactured or intended for delivering or ensuring the delivery of critical medical care or for use 
requiring fail-safe performance in which failure could lead directly to death, personal injury or severe physical or 
environmental damage. Seller’s warranty does not apply insofar as claims result from acts or omissions caused by 
persons other than Seller or from products, material or software not provided by Seller. 
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c. Buyer is responsible for the supervision, management and control of the use of the System, and output thereof, 
including, but not limited to: (a) selection of the System to achieve Buyer’s intended results; (b) determining the 
appropriate uses of the System in Buyer’s business or clinical setting; (c) establishing adequate independent 
procedures for testing the accuracy of the System; and (d) establishing and making use of adequate backup to 
obtain accurate data and prevent the loss of data in the event of a malfunction of the System. 

d. By purchasing the System, Buyer is not permitted to and agrees not to (a) reverse compile, reverse assemble, 
reverse engineer, modify, or incorporate the software embedded in the System (the “Software”) in whole or in part in 
any other product or create derivative works based on all or any part of the Software, (b) remove any copyright, 
trademark, proprietary rights, disclaimer or warning notice included on or embedded in any part of the Software, (c) 
sell, license, sublicense, assign, rent, or otherwise transfer the System, any components thereof or the Software 
without the written permission of Seller, or (d) otherwise tamper with the Software or workings of the System. 

e. If Buyer breaches Paragraph (d) or fails to pay when due any portion of the purchase price of the System or any 
component thereof or any other payment required from Buyer to Seller, whether under the contract or otherwise, all 
warranties and remedies granted in this section and all of Seller’s warranties and obligations to service, repair, 
replace, correct or otherwise remedy defects, errors or failures under any other contract between Buyer and Seller 
may, at Seller’s option, be terminated. 

f. LIMITATIONS ON REMEDIES. Seller’s liability in contract, tort or otherwise arising out of or in connection with use 
of the System, any component or output thereof, shall not exceed the amount that Buyer has paid Seller or its 
authorized distributor. An essential purpose of the limitation on remedies provided in this paragraph is the allocation 
of risks between Buyer and Seller. IN NO EVENT INCLUDING NEGLIGENCE SHALL SELLER BE LIABLE FOR 
SPECIAL, INCIDENTAL, TORT, CONSEQUENTIAL OR ANALOGOUS DAMAGES (INCLUDING, WITHOUT 
LIMITATION, ANY DAMAGES RESULTING FROM LOSS OF USE, LOSS OF DATA, LOSS OF PROFITS, LOSS 
OF GOODWILL, OR LOSS OF BUSINESS) ARISING OUT OF OR IN CONNECTION WITH THE PERFORMANCE 
OF THE SYSTEM AND/OR SELLER'S PERFORMANCE OF SERVICES, EVEN IF SELLER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT APPLY TO CERTAIN 
BUYERS. IN NO EVENT SHALL SELLER’S TOTAL LIABILITY TO BUYER FOR ALL DAMAGES EXCEED THE 
AMOUNT BUYER HAS PAID SELLER OR ITS AUTHORIZED DISTRIBUTOR. 

 
Copyright © 2015 Magellan Diagnostics, Inc. 
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Appendix A  Specifications,  
Specimen and Operating 
Requirements 

This chapter provides specifications for the LeadCare Ultra® Blood Lead Testing System. 

Table A-1: LeadCare Ultra System Specifications 

Overview 
System Description 6-channel, electrochemical blood lead analyzer 

Throughput Up to 90 tests per hour 
Analysis Time 3 min. (180 sec.) 
Analytical Range 1.9 µg/dL - 65.0 µg/dL 
LoD 1.9 µg/dL 
LoQ 1.9 µg/dL 
Calibration Electronic calibration; Lot specific 
Barcodes UPC/EAN, Code 39, Code 32, Code 128, Code 93, Codabar/NW7, 

Interleaved 2 of 5, MSI Plessey, GS1 DataBar 
Certifications CE, ETL, FDA-cleared 
General Specifications 
Dimensions (approximate, system) Height   58 cm 23 in (23 in.) 

Width    46 cm (18 in.) 
Depth    56 cm (22 in.) 

Weight (approximate, system) 15.4 kg (34 lbs) 
Electrical Specifications (Power adapters are included with system) 
External Power Source, Analyzer Switching power supply (AC input 100/240V, .1A max,  

50-60Hz, DC output +15V @ 2A max) 
DC Input Power (External Mode) Less than 180mA 
Specimen Requirements 
Sample Type Capillary whole blood (EDTA or Heparin) that is: 

• Free of blood clots. 
• Shipped and stored between 1°C - 25°C (33°F - 77°F), refrigerated or 

room temperature conditions. 
• Mixed with treatment reagent within 72 hours from time of blood 

collection.  
Sample Volume 50 µL  

 

http://www.magellandx.com/
http://www.magellandx.com/�
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System Operating Ranges 
Temperature 16°C - 30°C (61°F - 86°F ) 
Relative Humidity 12% - 80% Relative Humidity (non-condensing) 
Altitude LeadCare Ultra System can be operated in altitudes up to 8,000 feet 

(2,440 meters) above sea level. 
Storage Ranges 
Analyzer 15°C - 30°C (59°F - 86°F )  

Up to 80% Relative Humidity 
Test Kit 15°C - 27°C (60°F - 80°F )  

12% - 80% Relative Humidity 
Shipping Environmental Ranges 
Analyzer -30°C - +40°C (-22°F - +104°F)  

10% to 80% Relative Humidity, non-condensing 
Test Kit 15°C - 27°C (59°F - 80°F)  
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A.1 Interference Substances 
Tests were conducted by adding the potential interferences at the concentrations listed below to bovine 
and/or human lyophilized blood with elevated lead levels. Lead results for samples with each potential 
interference did not differ statistically from lead results obtained on unadulterated samples. 
 
The following substances at the following concentrations do NOT affect the results of the LeadCare Ultra 
Blood Lead Testing System: 
 
• 5,5-Diphenylhydantoin (phenytoin), 100 µg/mL 
• Acetominophen, 500 µg/mL 
• Acetylsalicylic Acid, 599 µg/mL 
• Aluminum, 10 µg/mL 
• Amoxicillin, 100 µg/mL 
• Amphotericin, 50 µg/mL 
• Arsenic III, 0.01 µg/mL 
• Arsenic V, 0.005 µg/mL 
• Ascorbic Acid, 100 µg/mL 
• Cadmium, 0.05 µg/mL 
• Carbamazepine, 100 µg/mL 
• Carboplatin, 0.5 µg/mL 
• Cephalexin (Keflex), 120 µg/mL 
• Ciprofloxacin, 100 µg/mL 
• Clondine, 100 µg/mL 
• Copper, 2 µg/mL 
• Cyclophosphamide, 500 µg/mL 
• d-Amphetamine Sulfate, 100 µg/mL 
• Diphenylhydramine Hydrochloride, 100 µg/mL 
• Doxorubicin, 100 µg/mL 
• Doxycycline, 100 µg/mL 
• Erythromycin, 100 µg/mL 
• Ferric Chloride, 100 µg/mL 
• Ferrous Sulfate, 100 µg/mL 
• Fexofenadine HCl (Allegra), 50 µg/mL 
• Fluconazole (Diflucan), 100 µg/mL 
• Gabapentin, 100 µg/mL 
• Ganciclovir (AZT), 100 µg/mL 
• Glyburide, 100 µg/mL 
• Guanfacine, 100 µg/mL 

 

• Hydroxyurea, 250 µg/mL 
• Ibuprofen, 500 µg/mL 
• Indinavir Hydrate, 100 µg/mL 
• Isoniazid, 100 µg/mL 
• Loratadine, 100 µg/mL 
• Methotrexate, 250 µg/mL 
• Methyl Phenidate (Ritalin) HCl, 100 µg/mL 
• Metronidazole, 50 µg/mL 
• Naproxen sodium, 500 µg/mL 
• Niacin, 100 µg/mL 
• Nicotine, 5 µg/mL 
• Nystatin, 100 µg/mL 
• Penicillamine, 25 µg/mL 
• Phenylephrine, 100 µg/mL 
• Piperazine, 100 µg/mL 
• Pseudoephedrine (guiafenesin), 100 µg/mL 
• Pyridoxine, 100 µg/mL 
• Riboflavin, 6 µg/mL 
• Rifampicin, 100 µg/mL 
• Salicylic acid, 600 µg/mL 
• Sitagliptin, 50 µg/mL 
• Succimer (Dimercaptosuccinic acid), 100 µg/mL 
• Sulfamethoxazole, 400 µg/mL 
• Thiamine, 20 µg/mL 
• Trimethoprim, 100 µg/mL 
• Uric Acid, 100 µg/mL 
• Valproic Acid, Na salt, 500 µg/mL 
• Vitamin D3, 100 µg/mL 
• Wafarin (Coumadin), 100 µg/mL 
• Zinc, 10 µg/mL 
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Appendix B Setup Guide 
In the event it is necessary for your laboratory personnel to set up the system on their own, follow the 
steps detailed in this Setup Guide. If you have any questions during the process please contact 
Magellan Diagnostics Product Support at 800-275-0102 or LeadCareSupport@magellandx.com. 

B.1 Establishing the Work Area 
The following parameters should be considered when choosing the placement of the LeadCare Ultra® 
System within the laboratory:  

• The system occupies an approximate bench space of 21 inches wide by 25 inches deep by 18 
inches high.  

• The system requires two (2) grounded electrical outlets. 

• Set up the LeadCare Ultra Blood Lead Testing system in an area that is free of drafts and 
temperature extremes. For best results, the analyzer needs to operate in a stable temperature 
environment: 

o 16°C - 30°C (61°F - 86°F) 

o 12% - 80% Relative Humidity (non-condensing) 

B.2 Setting Up the Analyzer and Computer Components 

B.2.1 Unpacking the System 

LeadCare Ultra materials are contained in two separate main packages, the Analyzer Kit box and the 
Computer System Kit box, each containing multiple components as described in Tables 1 and 2. 

1. Carefully remove the packages from the shipping boxes and inspect them for damage. If 
you notice any damage, report it to Magellan Diagnostics, Inc. immediately. 

2. Unpack the boxes keeping the components from the Analyzer Kit box together, and the 
components from the Computer System Kit box together, for easy access and 
identification during equipment set-up. Use the checklists below to confirm that all 
components are present. 

3. Record all serial numbers of the components on the Installation Checklist provided by 
Magellan Diagnostics. 

4. Review the manufacturer’s instruction for setting up the AIO stand, monitor and soundbar. 
Review the LS9208 Quick Start Guide for Connecting the Barcode Scanner. These 
documents can be found in the corresponding boxes.  

5. If you are connecting an optional printer, follow the installation guidelines in Section B.4. 

http://www.magellandx.com/
http://www.magellandx.com/�
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Table B-1: Analyzer Kit Box Contents 

Box Analyzer Kit  Check 
1 Analyzer 

Power Cable and Adapter 
USB Cable  
User’s Guide  
 

 
 
 
 
 

 

Table B-2: Computer System Kit Contents 

Box Computer System Kit Check 

1 Soundbar Box 
• Soundbar 
• USB Extension Cable 

 

 
 

2 

 

Monitor Box 
• Monitor 
• VGA Monitor Cable 
• USB Upstream Cable  
• Power Supply 

 
 
 
 
 

3 Keyboard Box 
• Keyboard with USB cable attached 

   
 
 

4 AIO Stand Box 
• AIO Stand 
 

    
 

5 Computer Box 
• Computer 
• Mouse and extra power cord 
• Barcode Scanner and hands-free stand 
• Serial/USB cable (Grey) 
 

     
 
 
 
 

 
NOTE: The following items included in the LeadCare Ultra boxes, are NOT 

necessary for setup:  
• Cable cover for monitor, silver monitor stand, and display port 

cable. (All found in Monitor box.)  
• Computer cable cover. (Found in AIO box.)  
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B.2.2 Manufacturer’s Instruction for Setup 

Follow the manufacturer’s instruction for setting up the AIO Stand, Monitor and Soundbar. Follow the 
LS9208 Quick Start Guide for connecting the Barcode Scanner. 

Prior to beginning system setup please read the following important information regarding the power 
cords and cables supplied with the system: 

NOTE: Use only the AC power adapters supplied with this system. 
Attempting to use adapters from different manufacturers could 
damage the analyzer or the computer. 

The power adapter carries appropriate ratings for safety, immunity 
and emissions. 

 

NOTE: During setup please make note of model numbers and serial 
numbers on the Installation Checklist found in the Validation Booklet 
provided by Magellan Diagnostics.  

  

Set Up AIO Stand and Connect the Monitor 
Refer to the instructions provided in the monitor box. Place the AIO stand on a stable, level surface. 

1. Attach the monitor to the stand. 
2. Connect the power cable from the stand to the monitor. 
3. Connect the VGA cable to the monitor. 
4. Route the VGA cable through the front slot of the stand. Leaving sufficient slack, tuck the 

monitor cable into the cable channel. 
5. Connect the USB upstream cable to the USB upstream port on the monitor. Leaving 

sufficient slack, tuck into the cable channel. 

Connect the Soundbar 
Refer to the instructions provided with the soundbar.  

1. Remove the slot covers found at the bottom of the Dell Monitor. 
2. Attach the soundbar to the monitor by sliding it to the right to lock into place. 
3. Connect the attached USB cable to USB port on the back of the computer.  

Set Up the Computer  
1. Slide the computer chassis into the AIO stand. 
2. Slide the switch to lock the computer to the AIO stand. 
3. Plug in the power supply from the AIO stand to the computer 
4. Connect cables from the monitor to the back of the computer. 
5. Discard the cable cover for the computer chassis. Do NOT Install. 
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Set Up the Mouse and Keyboard 

1. Connect the USB cables from the mouse and keyboard to the back of the computer. 

Connect the Barcode Scanner 
Refer to the “LS9208 Quick Start Guide” to connect the scanner to the computer 

1. Connect the Ethernet end of the cable to the base of the barcode scanner. 
2. Connect the USB end of the cable to the back fo the computer. 

Connect the LeadCare Ultra Analyzer 
1. Set the analyzer up in front of the monitor. 
2. Connect the B type end of the USB cable to the back of the analyzer. 
3. Connect the USB end of the cable to the back of the computer. 
4. Connect the power adapter to the back of the analyzer. 
5. Connect the AC adapter into a wall outlet. 

 

B.3 Registering Your System 
Please take a moment to complete the registration form online at: 
https://www.magellandx.com/leadcare-products/leadcare-ultra/support/getting-started/ 

Registering your analyzer with Magellan Diagnostics will allow you to receive important updates to your 
LeadCare Ultra Blood Lead Testing System. 

B.4 Preparing for Operation 
At this point, you have set up and installed the LeadCare Ultra Blood Lead Testing System successfully 
as a stand-alone device. Follow the procedures outlined below to confirm the system is operational and 
prepare for daily use: 

a. Power On the System 
b. Initialize the Barcode Scanner  
c. Create User Accounts 
d. Calibrate the System 
e. Install a Printer (optional) 

 

a. Power On the System  
►  Follow These Steps 

1. Power on the computer, monitor, and analyzer (On/Off switch shown in Figure B-1).  
2. The main login screen will appear (Figure B-2). 
 

https://www.magellandx.com/leadcare-products/leadcare-ultra/support/getting-started/
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Figure B-1: Back of Analyzer 

 

Figure B-2: LeadCare Ultra Blood Lead Testing System with Main Log In Screen  

 

In order to use the LeadCare Ultra Blood Lead Testing System software you must establish a User 
Account. The Laboratory Manager or another laboratory designee with “Account Manager” privileges 
may assign or delete accounts, as well as change User passwords for the LeadCare Ultra software. 

The computer must be updated to reflect the proper time zone. Log in as the LIMS Administrator to 
change the Date/Time settings. This will be particularly important if your system is linked to LIS. 

On/Off 
Switch 

Adapter 
Cable 

USB 
Cable 
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If you are setting up the LeadCare Ultra System without the help of a Magellan Diagnostic 
Representative, or if you want to add or change User accounts, please follow the steps below. 
These steps can also be found in the chapter entitled Performing Other Tasks in the User’s 
Guide. 

  

NOTE: The LeadCare Ultra User Account Manager has five pre-defined 
Administrator fields and fifteen pre-defined Operator fields. 
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b. Initialize the Barcode Scanner 
If you installed your LeadCare Ultra System on your own, or if the barcode scanner was not initialized 
by the Magellan Diagnostic Representative, you must scan the barcode below to initialize the scanner 
before use. (Figure B-3)  

 

 Figure B-3: Barcode for Initializing Barcode Scanner 

 

The scanner makes three rapid beeps. The barcode scanner can now be used with the LeadCare Ultra 
System.  

NOTE: If the scanner beeps once, it has been previously initialized. 

The computer must be ON when scanning the barcode. 

 

NOTE: Barcode Scanner Not Connected – The Barcode Scanner does not need 
to be connected to the system in order to use the LeadCare  
Ultra User Application. The User Application defaults to manual entry mode 
when the barcode scanner is not connected. Specifically, if the scanner is 
not connected when the User Application starts, the “Barcode Reader Not 
Found” message will appear. Click Continue in response. The User 
Application can then be used to run samples; enter sample ID and other 
information manually via the keyboard. 

 

If you choose to install the barcode scanner at a later time, you must exit the LeadCare Ultra 
Application, follow the instructions in User’s Guide, and restart the application. 
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c. Create User Accounts 
► Follow These Steps 

1. Select the Account Manager User icon, type in the password, and press Enter. 
2. The LeadCare Ultra User Account Manager dialogue box appears, containing a chart with 

User Name, User Type, and Description fields. 
3. Select an appropriate User type, either an Operator or an Administrator. When the field is 

selected it will be highlighted and the Assign User field will become active. 
4. Enter the information for User Name; Password; Confirm Password; and Description. User 

Type is pre-defined. Then select OK. 
5. Click Apply to save changes. 
6. The User created will be on the Login screen. To get to the Login screen select Close on 

the bottom left of the “LeadCare Ultra User Account Manager” screen. 

  

d. Calibrate the System 
Once the LeadCare Ultra System has been installed and User accounts have been established, the 
system is ready for initial calibration. Log in to proceed. 

What is Calibration? 

Each LeadCare Ultra Test Kit comes with a specific calibration button coded for the sensors provided 
for that sensor lot #. The calibration button is coded with the data required for the analyzer to translate 
the raw signal measured on the sensor into the actual lead concentration of blood samples. 

When the calibration button is held to the button reader on the analyzer, the calibration data for the 
sensor lot is transferred to the analyzer. When the transfer is complete, a beep sound and a 
“Calibration Successful” message appears. The lot number from the calibration button then appears in 
the upper left-hand corner of the User Application to verify that the calibration was read properly. 

Calibration Procedure 

The first time you log onto the analyzer after installation, the “Calibration Required” dialog box appears. 
(Figure B-4) 

   

  

  

  

  

Figure B-4: Calibration Required Dialog Box 
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1. Remove the calibration button from the test kit you are going to use. (Figure B-5) 

   

  

  

  

  

 

Figure B-5: Calibration Button 

2. Hold the calibration button to the button reader until you hear the beep. (Figure B-6) The 
button must touch both the center contact and metal side of the button reader. 

   

  

  

  

  

  

  

  

  

  Figure B-6: Holding Calibration Button to Button Reader 

3. Calibration takes a few seconds. When calibration is complete, the analyzer beeps and the 
screen briefly shows a message stating that the analyzer was calibrated successfully. 
(Figure B-7). 

  

  

  

 

 Figure B-7: Successful Calibration Message 
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NOTE: Prior to beginning testing please review the important information regarding 
calibration outlined in the User’s Guide provided with the system. 

  

4. After the analyzer calibrates the Quality Control (QC) Information screen will pop 
up. For step-by-step instruction on entering QC information see Section 4.4 in the 
User’s Guide.  

  

e. Install a Printer (optional) 
We recommend HP LaserJet P1102w (or similar). 

Before connecting anything to the LeadCare Ultra System: 

1. Unpack the printer and remove packing material. 

2. Read the manufacturer’s instructions for an overview. 

3. Remove film from the ink cartridge per manufacturer’s instruction. 

4. Connect the power cord and adapter. Do NOT connect the USB cord. 

5. Turn on the printer. 

6. Load paper. 

► Follow These Steps 

1. Log into the System is as the LIMS ADMIN. 

2. Insert the Disk into the LeadCare Ultra Computer (D Drive).   

NOTE: The LeadCare Ultra User Application (UA) has disabled the auto-start 
function, therefore you will have to double click the drive in order to open it.  
 (If you don’t see it, reboot the system.)   

 

3. Auto-run the set-up wizard to start the installation process.   

4. Connect the printer’s USB cable to the LeadCare Ultra Computer when requested. 

5. Say NO to any add-on features and NO to updates. 

6. When prompted, say YES to sharing.  (If you don’t check off sharing, LeadCare Ultra 
operators will not have access to the printer.) 

7. Upon completion of the installation, print a Test Page. 

8. Log out of LIMS Admin account and log in as a User.  

9. Print a LeadCare Ultra report from the UA to confirm functionality. 
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If you accidentally selected the “Do not allow sharing” option, the LIMS Admin must: 

1. Login to the LIMS application  
2. Select Devices and Printer 
3. Go to Printer Properties 
4. Select Sharing Tab  
5. Click Share Printer 

 

 

The installation and set-up of your LeadCare Ultra Blood Lead Testing System is now complete.  

Please read the information detailed in the User’s Guide prior to performing testing. 

  

If you have any questions, contact Magellan Diagnostics Product Support at 800-275-0102 Monday 
through Friday between 8 AM and 6 PM (EST) or by email at LeadCareSupport@magellandx.com.  
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Appendix C Safety Data Sheets (SDS) 
 

This chapter contains the following LeadCare® Ultra Safety Data Sheets: 

 

• LeadCare Ultra/Plus Controls 
• LeadCare Ultra/Plus Treatment Reagent 

 
 

 

  

 

 

http://www.magellandx.com/
https://www.magellandx.com/uploads/2019/01/LeadCare-Ultra-Controls-Rev_1.pdf
https://www.magellandx.com/uploads/2019/01/LeadCare-Ultra-Controls-Rev_1.pdf
https://www.magellandx.com/uploads/2019/01/LEADCARE-ULTRA-TREATMENT-REAGENT-Rev_03.pdf
http://www.magellandx.com/�
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